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ACCQPrep HP150 Installation and Operation Guide
Safety Warnings

Safety Overview
Before installing, operating, or maintaining this equipment, it is 
imperative that all hazards and preventive measures are fully 
understood. While specific hazards may vary according to 
location and application, heed the following general warnings:

WARNINGWARNING
Liquids associated with this instrument may be classified 
as carcinogenic, biohazard, flammable, or radioactive. 
Should these liquids be used, it is highly recommended that 
this application be accomplished in an isolated 
environment designed for these types of materials in 
accordance with federal, state, and local regulatory laws, 
and in compliance with your company’s chemical/hygiene 
plan in the event of a spill. 

WARNINGWARNING
Avoid hazardous practices! If you use this instrument in 
any way not specified in this manual, the protection 
provided by the instrument may be impaired.

WARNINGWARNING
If you are using flammable solvents or chemicals with this 
system, vapor concentration levels may exceed the 
maximum exposure levels as recommended by OSHA 
Guide 1910.1000. To reduce those levels to a safe exposure, 
Teledyne ISCO recommends that you place the system in 
a laboratory hood designed for the purpose of ventilation. 
This hood should be constructed and operated in 
accordance with  federal state and local regulations. In the 
event of a solvent or chemical spill, your organization 
should have a plan to deal with these mishaps. In all cases, 
use good laboratory practices and standard safety 
procedures.

Hazard Severity Levels This manual applies Hazard Severity Levels to the safety alerts. 
These three levels are described in the sample alerts below.

CAUTION
Cautions identify a potential hazard, which if not avoided, may 
result in minor or moderate injury. This category can also warn 
you of unsafe practices, or conditions that may cause property 
damage.
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WARNINGWARNING
Warnings identify a potentially hazardous condition, which 
if not avoided, could result in death or serious injury.

DANGER
DANGER – limited to the most extreme situations 
to identify an imminent hazard, which if not 
avoided, will result in death or serious injury.

Hazard Symbols The equipment and this manual use symbols used to warn of 
hazards. The symbols are explained in the table below.

Hazard Symbols 

Warnings and Cautions

The exclamation point within the triangle is a 
warning sign alerting you of important instructions 
in the instrument’s technical reference manual.

The lightning flash and arrowhead within the trian-
gle is a warning sign alerting you of “dangerous 
voltage” inside the product.

Symboles de sécurité

Ce symbole signale l’existence d’instructions 
importantes relatives au produit dans ce manuel.

Ce symbole signale la présence d’un danger 
d’électocution.

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnze-
ichen, das Sie darauf aufmerksam macht, daß 
wichtige Anleitungen zu diesem Handbuch 
gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, 
das Sei vor “gefährlichen Spannungen” im 
Inneren des Produkts warnt.

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las 
instrucciones del manual que acompañan a este 
producto.

Esta señal alerta sobre la presencia de alto vol-
taje en el interior del producto.
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For Additional 
Information

Technical assistance for the Teledyne ISCO ACCQPrep HP150 
can be obtained from:

Teledyne ISCO 
4700 Superior St. 
Lincoln NE 68504

Phone: (800) 775-2965 or (402) 464-0231 
Fax: (402) 465-3001 
E-mail:  IscoService@teledyne.com
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ACCQPrep HP150

Section 1  Introduction 

1.1 Overview This Operation Guide provides the following:

• Safety information 

• Instrument configuration options

• A basic system operation guide

• Networking instructions to connect the ACCQPrep 
HP150 with Windows and iOS operating systems

• Certification and warranty information

1.2 Product Overview The Teledyne ISCO ACCQPrep HP150 chromatography system 
combines high resolution and productivity in a small footprint. It 
features easy to use software, programmable gradients, UV 
detection and peak collection, and automatic detection of col-
lection tube racks. Its small size makes it a great personal 
system and well-suited for operation within chemical hoods and 
other limited indoor spaces. The extended pressure capability 
supports operation of columns at high flow rates for maximum 
throughput or added tolerance for high back pressures as 
columns age.

WARNING
Avoid hazardous practices! If you use this instrument in 
any way not specified in this manual, the protection 
provided by the instrument may be impaired; this may 
increase your risk of injury.

The ACCQPrep HP150 is available in different configurations to 
meet your needs. An optional Solvent Selector Valve Module sup-
ports up to three choices for solvent A and three different choices 
for solvent B. Detection options include UV, UV/Vis, ELSD, and a 
mass spectrometer capable of detecting your compounds with up 
to four individual mass signals, including a range of masses. 
Automation options include the AutoInjector, the AutoSampler, 
and the Column Selector modules.

AutoInjector Module The AutoInjector is an optional module for the ACCQPrep-
system. The AutoInjector module is necessary for stacked injec-
tions. When installed, it performs automated, repetitive 
compound injections completely unattended. This allows you to 
automatically purify larger amounts of compound than can be 
purified with a single separation run, increasing productivity. 
And, when the optional column switcher and solvent switching 
valves are installed, you can test different chromatographic con-
ditions for a single sample. Following PeakTrak’s on-screen 
instructions for the AutoInjector eliminates carry-over between 
samples.
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AutoSampler Module The AutoSampler is an optional module for the ACCQPrep 
system. When installed, it automates purification when you have 
several different samples that require multiple injections and 
different chromatographic conditions. It can be used unattended: 
it moves its probe robotically and automatically washes it 
between samples to eliminate carry-over. The AutoSampler uses 
RFID rack swapping technology to allow you to replace com-
pleted racks.

Column Selector Module The Column Selector module supports up to four Prep HPLC 
columns ranging from 4.6 mm up to 50 mm inner diameter 
(Larger columns may be used at less than optimum flow rates.) 
PeakTrak software operates the module's column selector valve.
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Figure 1-1 ACCQPrep HP150

ACCQPrep HP150 – This Prep HPLC system has flow rates 
from 1–150 mL/min, with up to 6000 psi capability. A two com-
ponent gradient can be formed from up to six solvents. An addi-
tional third solvent modifier pump is available to pump a fixed 
percentage of modifier. The system includes active solvent level 
sensing and detection of a full waste container. The base system 
includes two fraction collection racks. Two different AutoSampler 
options extend the number of collection racks on the system to 
four or six respectively. The RFID tagged racks can be replaced 
while in operation with new racks for practically limitless 
fraction collection.

ACCQPrep HP150 with optional ELSD  – This system has 
the same high performance features as the ACCQPrep HP150 
system but also includes an internal evaporative light scattering 
detector (ELSD). During operation, this detector can be com-
bined with the UV (200–400 nm) or UV-vis (200–800 nm) 
detection to isolate visible and UV absorbing compounds as well 
as compounds with little or no chromophores. 
ACCQPrep  HP150  with  optional  PurIon Mass 
Spectrometer  – This system has the same features as the 
ACCQPrep HP150 but also includes a mass spectrometer with a 
detection range of 10 to 1200 Daltons (Da) (PurIon S) or 
10–2000 Da (PurIon L systems). During purification, this system 
can be combined with the UV (200–400 nm) or UV-Vis 
(200–800 nm) detector to isolate visible and UV absorbing com-
pounds as well as compounds with specific molecular weights or 
mass ranges. 
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1.3 Operating Overview The ACCQPrep HP150 system is equipped with a capacitive 
touchscreen display for local control.

The system also supports TCP/IP communication. This allows 
direct control of the system by an external computer between 
Ethernet ports of the ACCQPrep HP150 system and the com-
puter. 

TCP/IP communication also allows remote control of the system 
via an established network. Remote controlling devices on the 
network can be Windows or Apple desktop and laptop computers 
or Apple iOS mobile devices (iPod Touch, iPhone, and iPad).

Note
Teledyne recommends that you obtain assistance from your 
Information Technology department before attempting direct or 
network connections. See Technical Note 28 Networking 
Guidelines on the Teledyne LABS website for more information. 

1.3.1 Multiple Control 
Possibilities

The system can be accessed from the built-in touch panel and by 
up to ten network devices. The touch panel shares control with 
all connected devices. The system performs the most recent 
command from any control input.

1.3.2 File Storage To support operation from a variety of direct and network con-
nections, the software and all files are stored in the ACCQPrep
HP150. This ensures that your compound purification methods 
and run history files can be viewed from any connection. 
Optionally, run files may be saved to a USB flash drive, a net-
worked controlling computer, or a network drive.

1.4 Safety Components Before installing, operating, or maintaining this equipment, it is 
imperative that all hazards and preventive measures are fully 
understood. Refer to the Safety Overview section at the front of 
this operation guide for general safety information. 

1.4.1 Power disconnects The power cord is a safety disconnect for the ACCQPrep
(Figure 1-2). 

To remove power from the ACCQPrep, remove the power cord by 
pulling it straight out from the power inlet connector. The circuit 
breaker is located adjacent to the power inlet connector. If an 
internal circuit fault occurs, this breaker will trip. It can be reset 
by pressing the end of the rocker labeled “|”. In addition, 
switching the breaker manually to the “O” position removes 
power from the internal operating components.

https://www.teledynelabs.com/documents
https://www.teledynelabs.com/documents
https://www.teledynelabs.com/documents
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Figure 1-2 Location of power cord for the ACCQPrep 

1.5 Specification 

Table 1-1  ACCQPrep HP150

Dimensions of ACCQPrep  
(Footprint without column installed)

27.5 x 14.0 x 20.0 in (69.9 x 35.6 x 50.8 cm)

Dimensions of ACCQPrep AS 2x1 18.9 x 14.0 x 19.3 in (48.0 x 35.6 x 49.0 cm)

Weight

(Including AutoInjector, Column Selector 
Valve Module, Solvent Selector Valve Mod-
ule, and column cover)

93.2 lbs (42.3 kg)

106 lbs (48 kg) with optional Evaporative Light Scattering Detector 
(ELSD)

Weight of ACCQPrep AS 2x1 27.3 lbs (12.4 kg)

User Interface 15" touchscreen

Power Input voltage range from 100 to 240 VAC,

300 VA maximum.

Line cord is the disconnect device. Power connection is via IEC 
60320 C14 power inlet. 

Line Frequency 50/60 Hz

Ambient Temperature 20 to 40 °C (maximum temperature must be at least 15 °C below the 
boiling point of the solvent)

Humidity (when connected to power) 90% relative humidity maximum at 20 to 40 °C (non-condensing)

Flow Rate Range 1-150 mL/min, ELSD fraction collection limited to 4-150 mL/min

Flow Rate Accuracy (tested with water at 
6.9 bar or 100 psi)

± 2%

Pressure Limit 414 bar (6000 psi) derated linearly from 6000 psi at 75 mL/min to 
3000 psi at 125 mL/min; and to 2000 psi at 150 mL/min. 

Pressure Accuracy 5% of full scale

Gradient Formation Binary gradient 2 solvent inlets. Optional Solvent Selector Valve Mod-
ule expands to 3 solvents each for A & B. Optional Solvent Modifier 
Module allows addition of third solvent for ternary gradient formation.

Gradient Accuracy: ±1% of full scale (typical) 

Peak Detection Modes Slope or threshold

Flow Cell Pathlength 0.3 mm, ±25% (Standard, other pathlengths available)
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UV Detection Wavelength 200 to 400 nm, optional 200 to 800 nm UV-Vis

UV Lamp Source Deuterium

Wavelength Accuracy ±5 nm

Fraction Accuracy ±[2mL  (flow rate  60)] 

Optional ELSD 

Gas Inlet Pressure 60 to 70 psig 

Gas Consumption <2.5 SLPM

Spray Chamber Temperature Setting range: 10 to 60 °C

limited to minimum of 5 °C below ambient

Drift Tube Temperature Setting range: 30 to 90 °C

Must be 5 °C above spray chamber temperature Minimum tempera-
ture is 5 °C above ambient Maximum temperature is 60 °C above 
ambient

Electrical Safety per EN 61010-1

Pollution Degree 2

Installation Category II

Maximum Altitude 2000 meters

Note 1. All specifications are subject to change.

Table 1-1  ACCQPrep HP150

Table 1-2  ACCQPrep HP150 with PurIon System

Dimensions (H x W x D) ACCQPrep: 27.5 x 14.0 x 20.0 in (69.9 x 35.6 x 50.8 cm)

Mass Spectrometer 26 x 11 x 22 in (66 x 28 x 56 cm)

Roughing Pump 10 x 9 x 18 in (26 x 23 x 46 cm)

ELSD Detection Option that can be combined with either UV or UV-Vis

Mass Spectrometry Detection

10 – 1200 Dalton for S model, 10-2000 for L model,  
1 Dalton Resolution

Electrospray Ionization (ESI) or optional Atmospheric Pressure 
Chemical Ionization (APCI)

Simultaneous positive and negative ionization for both S and L  
models.

Note 1. All specifications are subject to change.

Table 1-3  Component Materials List

Chromatographic Tubing 316 stainless steel tubing, PEEK, and 
Fluoropolymer

Drain Tubing Vinyl with FEP liner

Chromatographic Valves PEEK, PPS, perfluorelastomer (FFKM)

Flowcell 303 SST, Type ES Quartz, SIMRIZ® SZ485®

Chromatography Pump 316 Stainless Steel, UHMWPE, ETFE, ruby, sapphire, and zirconia
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Pressure Transducer 316 and 17-4 PH stainless steels and perfluorelastomer (FFKM)

AutoSampler Wash Pharm-A-Linepolypropylene 

Table 1-3  Component Materials List
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ACCQPrep HP150

Section 2  Configuration

2.1 Configuration of the 
ACCQPrep

The CONFIGURATION window (TOOLS > CONFIGURATION) groups 
its settings on tabs placed along its top.

Solvent settings, the default tube volume, the system name, and 
the time zone setting (Figure 2-1) can be found under TOOLS > 
CONFIGURATION > INSTRUMENT CONFIGURATION.

I

Figure 2-1 Instrument Configuration
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Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6).

When the Solvent Selector Valve Module is present, you can 
select the solvents  for  both SOLVENT A and B from the 
INSTRUMENT CONFIGURATION tab (Figure 2-1). If the valve is 
absent, the solvents are selected on the MAIN RUN screen, and 
these options are not shown in the CONFIGURATION window. 
INSTRUMENT CONFIGURATION will still show the ADD SOLVENT 
and REMOVE SOLVENT buttons to edit the list.

If you do not see your solvent name on the list, select ADD 
SOLVENT, then type in the solvent name. You can also REMOVE 
SOLVENT names that you no longer use.

Modifier Type (ACCQPrep HP150 with 3rd Solvent 
Modifier Module) – This allows you to choose which solvent 
your modifier is dissolved in.

Solvent Level Sensing – 

• ENABLE SOLVENT LEVEL SENSING monitors the solvent 
level in each of the supply containers. 

• ENABLE WASTE LEVEL SENSING stops the system when 
the waste level reaches approximately one inch above 
the sensing line.

Low Pressure Limit – A pressure (in psi). In a high pressure 
system, if the pressure is below this level for a significant time, it 
is likely that there is a leak somewhere. When ENABLE LOW 
PRESSURE LIMIT is selected, the system will shut down when the 
low pressure limit is not reached.

ACCQPrep Name – A label for the system. Reports printed by 
the system have this label, so a unique system name identifies the 
source of the report. Useful when more than one system is in use.
Set Date/Time – The date and time, including a time zone. All 
separations not named previously are tagged with the date and 
time of operation. Usually the local date and the current time are 
entered. If the selected time zone observes daylight savings time, 
the system automatically changes the time as required. 
SET DATE/TIME requires the administrator password.
Set Default Tube Volume – Determines how much is collected 
in each test tube. A suggested amount is preset, but if you prefer
another level of fluid in each test tube, you can enter the tube 
volume you would like to use. This amount becomes the default 
used for new methods, but it can be changed within the METHOD 
EDITOR.
Queue Screen Custom Parameters – The parameter chosen 
here displays a column of editable parameters on the QUEUE tab 
of the MAIN screen. 

• UV/UV-VIS THRESHOLD sets the threshold for detection.

• DETECTION IONS selects the ions for the PurIon mass 
spectrometer.
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If data isn’t entered, the default threshold is used, or the mass 
spectrometer will not collect data unless a method that has these 
parameters entered is used.

2.2 Network 
Configuration

TOOLS > CONFIGURATION > NETWORK CONFIGURATION is used to
connect the system to a network. While not required, doing so 
allows you to remotely view the user interface for monitoring or 
controlling the system, print to a network printer, or automati-
cally save data files directly to the network. 

To connect to a network, you need access to IP addresses and
network information from your IT department. For more infor-
mation about networking, see TN28 Networking Guidelines for 
CombiFlash Products available at www.teledynelabs.com.

See 4.3.12  Network Configuration Options for more information 
about using PeakTrak to network the ACCQPrep HP150.

2.3 User Preferences TOOLS > CONFIGURATION > USER PREFERENCES sets display units 
and the language for the logged-in user.

Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6).

Figure 2-2 User Preferences configuration

Language  – Sets the language for the user interface; several 
languages are available. If you have set up the system for mul-
tiple users, each user can select a preferred language.

Automatically Print Report – Prints a report at the end of a run 
if you are connected to a network.

https://www.teledynelabs.com/en-us/resources/Documents/Technical-Notes/Networking-Guidelines-For-Chromatography-Products.pdf
https://www.teledynelabs.com/en-us/resources/Documents/Technical-Notes/Networking-Guidelines-For-Chromatography-Products.pdf
https://www.teledynelabs.com/en-us/resources/Documents/Technical-Notes/Networking-Guidelines-For-Chromatography-Products.pdf
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Graph System Pressure  – Shows the system pressure during a 
separation. This information is useful for troubleshooting a 
system that doesn’t appear to operate as expected.

For normal operation, selecting GRAPH is not recommended. 
This information is always stored with the run data for later
review, so if a problem is suspected, this parameter can be selected 
and the suspect separation opened to review the pressure profile 
during the separation.

The pressure trace doesn’t have a vertical scale with pressure. To 
view the actual pressure at a point in time, refer to the status bar in 
the upper right corner of the screen during a separation. If you are 
reviewing a previous separation, this information isn’t available on 
the screen, but the profile of the trace is often adequate for trouble-
shooting. 

Show Absorbance During Equilibration – Shows absorbance 
of the system during equilibration to verify baseline stability.

Pressure Units – Instructs the system to display pressure as 
PSI or Bar.

2.4 Prep HPLC Columns and methods can be defined and deleted using 
TOOLS > CONFIGURATION > PREP HPLC (Figure 2-3).

Note
You can back up and restore instrument settings and data 
using Help > Backup / Restore (Section 4.2.6).

Figure 2-3 Prep HPLC configuration

Loop Volume – The ACCQPrep uses the installed loop volume 
for several calculations within the software, including ELSD 
peak alignment and focused gradient optimization. It is 
important to update this value if loops are changed on the 
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system. It ensures that the samples entered do not exceed the 
loop volume amount per injection. For manual injections, a 
warning displays if half of the loop volume is exceeded, but it 
does not limit the injection amount that can be programmed. 
When using an AutoInjector or the AutoSampler module, the 
injection volume error will only indicate when sample may be 
lost to the injector. This warning can be ignored. 

Column Position – This allows you to define a column(s) used on 
the instrument. If you do not have the Column Selector Valve 
Module (CSV-4), you can define multiple columns and select 
which column is currently connected. If you have the CSV-4 
installed, you can configure the columns that are installed. The 
name of the column used for the separation is recorded on the 
report. This name can be descriptive for the column, or identify it 
exactly using the column serial number.

Probe Type – The probe type, described by material. The 
standard PTFE probe supplied with the instrument is the 
default. You can also select the optional “Steel” needle available 
for piercing vials with an aluminum foil cover to prevent evapo-
ration. This optional probe is NOT able to pierce silicone septa. 
The steel probe has a slightly different internal volume that 
requires a different compensation volume.

Bracketed Sample – ““Brackets” the sample injection with air 
and a user supplied solvent to address potential solubility issues 
when injected. When selected, each separation defaults to using 
a bracketed sample injection protocol that can still be overridden 
for individual samples. Further details can be found in Section 
3.3.8. 

2.4.1 Define a Column Column size and type parameters are important to update for the 
system to work optimally. The calculated column volume from 
these parameters are used in several key features of the system 
including the focused gradient calculator and ELSD peak 
alignment.

To define a column at CONFIGURATION > PREP HPLC:

1. Select NEW. If you are accessing CONFIGURATION from the 
touchscreen, an on-screen keyboard opens.

2. Enter the name of the column. Select ENTER (touchscreen) 
or OK (remote computer).

3. To complete the column definition, enter the MEDIA SIZE 
and COLUMN DIMENSIONS.

4. Select the column’s INSIDE DIAMETER. A flow rate for a 
default method is selected based on scaling up the linear 
velocity of a 4.6 mL analytical column running at 
1 mL/min.

5. Select the LENGTH of the column. This provides the sug-
gested default method with about 10 column volumes for 
the gradient portion of the separation, along with an initial 
isocratic portion, a strong solvent portion to wash the col-
umn, and a portion that returns the column to a suggested 
storage fluid concentration.
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6. The PRESSURE LIMIT is set by default to 3000 psi (207 bar), 
which is a typical limit for preparative HPLC columns, but 
this can be changed for each column to a suitable pressure 
not to exceed the system pressure limit of 6000 psi.

7. SAVE the default method associated with the column.
To customize the new method while at CONFIGURATION > PREP 
HPLC, select DEFINE METHODS, then EDIT to view and modify all 
the method parameters. 

2.4.2 Delete a Column To delete a column at CONFIGURATION > PREP HPLC:

1. Be sure that the column to be deleted is not selected in a 
COLUMN POSITION field.

2. Select the column you would like to delete from the COL-
UMN NAME list.

3. Select DELETE.

4. If you get an error message stating that the method is cur-
rently in use, close the CONFIGURATION window. Go the to 
RUN screen and select a different COLUMN.

2.4.3 Creating Other 
Methods

Methods created at CONFIGURATION > PREP HPLC are associated 
with a particular column when created. If multiple methods are 
associated with a single column, these methods can be easily 
accessed whenever a particular column is selected. These 
methods are be shown in the column selection lists in the order 
the methods were created. 

To create the new method: 

1. Select TOOLS > CONFIGURATION. The CONFIGURATION win-
dow opens.

2. On the PREP SFC tab, select the Column Name that you 
want to associate with the new method. 

3. Select DEFINE METHODS (Figure 2-4). The PREP HPLC tab 
hides column options and shows method options.
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Figure 2-4 Define Methods

4. Select NEW. If you are accessing CONFIGURATION from the 
touchscreen, an on-screen keyboard opens.

5. Enter in the name you have chosen. Select ENTER (touch-
screen) or OK (remote computer).

6. The newly created method uses the default method  
parameters. To modify the new method:

a. Select EDIT. The METHOD EDITOR opens.

b. Make changes as needed in the METHOD EDITOR.

c. EXIT when completed.

2.4.4 Creating Scouting and 
Focused Gradients

PeakTrak offers an integrated tool for method optimization 
called the Focus Gradient Generator. This feature runs a 
scouting gradient on your sample to find the ideal focused gra-
dient conditions for your separation. Focused gradients offer a 
quick way to greatly improve resolution around the peaks of 
interest. 

To use the Focus Gradient Generator feature, you must first con-
figure your column to use a Scouting Gradient:

1. Select TOOLS > CONFIGURATION. The Configuration win-
dow opens.

2. On the PREP HPLC tab, select the COLUMN NAME that you 
want to associate with a scouting gradient.
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Figure 2-5 Column Configuration

3. Select DEFINE METHODS. Options for defining methods are 
then made available on the PREP HPLC tab.

4. Select NEW SCOUTING METHOD. This opens the SCOUTING 
METHOD FOR FOCUSED GRADIENT window (Figure 2-4).

5. Define the FLOW RATE, the INITIAL %B, and the FOCUS 
RANGE, and assign a METHOD NAME to the scouting 
method. This name is then listed among the methods that 
can be selected to run on the column that you selected in 
Step 1.

Figure 2-6 Scouting Method definition window 

After a scouting gradient has been defined, load the column and 
the scouting method:

1. In the Main screen, select the column that you want to use 
for the run.
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2. Select the scouting method you previously defined for that 
column (Figure 2-7).

Figure 2-7 Loading the Scouting method

3. After the column and method are selected, select START.

4. Input your injection parameters as usual, and let the run 
proceed (Figure 2-8).

Figure 2-8 Scouting Run screen 

A RUN screen appears upon completion of the run:

column
method
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Figure 2-9 Run screen at end of run

Next, define the focused gradient:

1. Select FOCUS GRADIENT from the bottom right of the Run 
screen (Figure 2-9). The FOCUSED GRADIENT DEFINITION 
window appears (Figure 2-10). 

Figure 2-10Focused Gradient Definition window 

2. Select the peak at which you would like your purification 
to be optimized. Using a finger on the touchscreen, you 
may move the vertical red line designating this peak as 
needed.
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3. Select the column for which to generate the optimized 
focused gradient from the list at the bottom of the window.

4. Select a FOCUS RANGE (±0% to ±20%).

5. Select FOCUS. An optimized method centered on the 
selected peak is generated. 

A possibility: a dialog warns you that the target compound eluted 
too early or too late, so the generated method may not be truly 
optimal. Possibly, early elution could be remedied by using 
another solvent system or column. See Section 3.4  Operation 
Troubleshooting (Peaks elute too early and Peaks elute too late) 
and the Teledyne’s Technical Note Focused Gradients—What Do 
You Mean the Compound Eluted Too Early or Too Late?! (TN61).

When the run is finished, a RUN VIEWER window opens to show 
the focused gradient.

A RUN VIEWER window displaying a previous scouting run 
(Section 4.4.7) may also make the FOCUS GRADIENT button 
available.

2.4.5 Calibrating HPLC Calibrating an analytical HPLC system to the ACCQPrep HP150 
can increase method development efficiency.

To calibrate the external HPLC, run universal test mix on both 
the external HPLC and the ACCQPrep with matching chemistry 
columns. Refer to Teledyne LABS Chromatography Technical 
Note 52 for that procedure. After the parameters are determined, 
enter them into the ACCQPrep HP150: 

1. CONFIGURATION > PREP HPLC tab > CALIBRATE EXTERNAL 
HPLC. The CALIBRATE EXTERNAL HPLC window opens 
(Figure 2-11).

2. Select ENABLED. 

3. Enter settings to calibrate the analytical HPLC system to 
the preparative HPLC system, then select OK to dismiss 
the CALIBRATE EXTERNAL HPLC window.

4. Select OK to dismiss CONFIGURATION and to reveal the 
MAIN screen.

To use the custom method, you must select it when you select a 
column for a separation:

1. On MAIN, select the RUN SCREEN tab.

2. Select a COLUMN. When a column is selected, a method list 
appears.

3. Select HPLC FOCUS from the list. The HPLC FOCUS win-
dow opens (Figure 2-12).

4. Enter the RETENTION TIME from your analytical system.

5. Enter a FOCUS RANGE (+/- 0, 5, 10, or 20%), then select OK.
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The Calibrate External 
HPLC window

Figure 2-11The Calibrate External HPLC window

Enabled -  – Provides columns with an HPLC Focus method 
using the gradient and calibration options selected on the Cali-
brate window.

External HPLC options

• GRADIENT INITIAL %B – The starting percentage of B 
solvent.

• GRADIENT FINAL %B – The ending percentage of B 
solvent.

• GRADIENT DURATION – The length of the gradient. It is 
not the total run time.

• CALIBRATION RETENTION TIME – Specifically, the 
retention time of the calibration compound.

ACCQPrep options

• CALIBRATION COMPOUND %B – The %B that causes the 
calibration compound to elute at the correct retention 
time.

• FOCUS RANGE – +/- 0, 5, 10, or 20%.
The HPLC Focus window

Figure 2-12The HPLC Focus window

2.5 Scheduled Operations Scheduled operations run sample queues at predetermined days 
and times. They are run after any samples in an existing queue 
are completed.
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Scheduled Operations are useful to

• wash all installed columns at the end of the day to 
remove buffers and modifiers, potentially improving 
column life,

• wash strongly retained samples from columns, and 

• periodically run reference standards to test retention 
times and peak shapes.

Scheduled Operations require sample queues saved to the 
system (Section 3.3.5). Each queue file must contain at least on 
operation. Entries from the file are added to the active queue and 
are run after queued samples.

Scheduled Operations can be found under TOOLS > CONFIGU-
RATION > SCHEDULED OPERATIONS tab (Figure 2-3). Here, up to 
three routine operations can be scheduled to be run as needed.

Figure 2-13Scheduled Operations

To schedule an operation, 

1. BROWSE to select a queue file to run.

2. Select ENABLE. Toggling ENABLE off disables the operation 
but retains its settings for later use.

3. Enter a TIME in a 24:00 format. The TIME ZONE set in CON-
FIGURATION (Section 2.1) is used by the scheduler.

4. Select at least one day. For example, column cleaning can 
be done every day, while column testing may be done once 
a week.
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Before a scheduled operation is run, make sure that the required 
solvents and samples are in place. Samples must be placed in the 
sample rack at the location listed in the saved sample queue. 
Prime pumps with the appropriate solvents when an operation 
such as column testing is scheduled.
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ACCQPrep HP150

Section 3  Operation

3.1 Introduction The ACCQPrep HP150 is unique in the Preparative HPLC 
market. It provides several methods of operation that you can 
select to fit your needs.

Methods contain all of the information used during a separation 
of a single sample, such as gradient profile, detection and peak 
cutting parameters, and fraction size. Repetitive sample injection 
is programmed as needed and doesn’t require creation of a sep-
arate file.

One of the unique features of the ACCQPrep is that a defined 
method file is not required for operation. A default or existing 
method can be loaded and modified for the current separation 
without the need to save the newly modified method.

In addition, any of the method parameters can be modified 
during the separation. None of these changes will affect the 
original method unless you choose to save the changes to the 
original method. All method and injection parameters used for 
starting the separation or modified during the separation are 
stored with the chromatographic data, so no information is lost.

In addition, the method and injection parameters used during a 
separation can be extracted from the data file and saved as a 
named method for future reuse.

3.2 Method Selection There is more than one way to select a method:

• Use a pre-programmed column that has methods 
associated with it. After the column is selected, select 
one of the associated methods. This is especially conve-
nient if you typically only use a few predefined methods.

• Use a method file that has been saved before. Go to 
FILE > OPEN. A FILES selection window opens. Sort for 
the method file (*.pmtd) that fits your needs and select it.

• Extract a method from a previous run. Go to 
FILE > OPEN. A FILES selection window opens. OPEN the 
run file (*.run) from a previous separation, then select 
EXTRACT on the lower portion of the Run file window.

If the method selected is adequate, select START to continue. If 
the method is not exactly as needed, the method can be edited. 
Edit the common parameters of any method either by adjusting 
the points on the graph, changing major parameters on the main 
screen, or by selecting the METHOD EDITOR. After it is edited, the 
method can be used directly for the immediate separation(s) or 
saved with a name for future reuse.
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3.3 Starting a Separation To separate a single sample, select START to start a separation. 
The MINIMUM RUN REQUIREMENTS window opens. Select an 
injection technique and select where the fractions will be col-
lected (the starting rack and tube position). The system projects 
the amount of solvent required and the separation duration. To 
proceed, select START EQUILIBRATION. 

For an ELSD If an ELSD is installed on the system, MINIMUM RUN REQUIRE-
MENTS provides the option to use the ELSD or disable it. Typi-
cally, ELSD method parameters are determined by the solvents 
used and are therefore somewhat universal when doing prepar-
ative separations of nonvolatile samples. Semi-volatiles may 
require optimization of the ELSD parameters. Peak delay com-
pensation is based on using water and methanol or water and 
acetonitrile and is selected on the basis of the names assigned to 
the solvents.

Note
Use the METHOD EDITOR to change the ELSD parameters. 

For a PurIon If a PurIon mass spectrometer is connected, the MINUMUM RUN
REQUIREMENTS and DETECTION OPTIONS windows allows some 
customization of the PurIon operating conditions. This allows the 
use of default or commonly used methods while allowing custom-
ization of the separation for both masses used for fractionation or 
mass loading of sample sent to the PurIon for detection. (Low 
mass load is the default and sends the minimum amount of 
sample to the PurIon for detection. Because of the high concen-
trations of sample in a preparative separation, this is adequate 
for most samples with good ionization.)

PurIon detection options can also be accessed from the METHOD 
EDITOR. Further information about these options be found in 
Section 4.3.4  Method Editor (under  Peak Detection).

If No AutoInjector or 
AutoSampler are 
Connected

If  you do not have an AutoInjector or AutoSampler, the 
ACCQPrep gives you the option of injecting the sample immedi-
ately or after column equilibration.

• LOAD NOW — If your sample is ready, you can inject it 
into the syringe port on the side. Select START EQUILI-
BRATION. No further intervention will be required on 
your part.

• LOAD AFTER EQUILIBRATION — This gives your column 
time to equilibrate while you finish preparing your 
sample. When the equilibration is complete, the system 
will pause and prompt you to inject your sample.

The next section covers starting a separation when the addi-
tional modules are set up. 
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3.3.1 Separation with an 
AutoInjector

To use the AutoInjector module:

1. Place the sample probe into your sample container.

2. Select START to start a separation as you would for an indi-
vidual separation. The MINIMUM RUN REQUIREMENTS win-
dow opens; in front of that, the SAMPLE OPTIONS window 
opens.

3. Select the SAMPLE TYPE.

a. If you want to automatically perform multiple injec-
tions (or to perform a single injection using the AutoIn-
jector Module), select AUTOINJECTOR as the SAMPLE 
TYPE (Figure 3-1). This is the default selection if an 
AutoInjector Module is present.

b. If an AutoSampler module is present, select AUTOSAM-
PLER.

If an AutoSampler or AutoInjector is not installed, they 
will not be listed as a SAMPLE TYPE.

Note
If you want to manually inject your sample without using the 
AutoInjector Module, replace the sample probe fitting with a 
Luer injection port (supplied) or 22 gauge needle port 
(optional).

Figure 3-1 Choosing an Injection Method

4. In the dialogue box, enter the TOTAL SAMPLE volume and 
the INJECTION VOLUME (Figure 3-2). PeakTrak divides the 
total volume by the injection volume to determine the 
number of injections for each separation. The number of 
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injections that these two volumes will yield is listed on the 
window.

Figure 3-2 Selecting the sample volume and number of 
injections

If the INJECTION VOLUME exceeds 50% of the loop volume, a 
warning message recommends a change in the parameters. This 
message can be ignored at your discretion. PeakTrak performs
exactly as programmed. It also compensates for the volume of 
tubing used for the supplied sample probe. If the sample probe is 
ever lost or damaged, replace it with the AutoInjector Needle 
Assembly (PN 60-5234-657). 

During the programmed separation sequence, any changes made 
to the method are included on any of the remaining injections. 
This includes automatic changes such as using the peak hold 
feature or automatic run length extension. For the most reliable 
operation, it may be best to disable these automatic features. 
Mid-separation flow rate changes will occur at the beginning of 
the next separation. Note that changes of flow rate do not auto-
matically affect the overall run length. 

5. After the last injection is performed, a sample probe wash 
screen is shown, prompting you to wash the probe with a 
strong solvent followed by a weak solvent. Perform these 
duties as requested.

Note
A weak solvent is used following the usage of the strong sol-
vent to inhibit poor separation due to excessive strong solvent 
in the probe tubing. It is important to perform Step 5 to ensure 
there is no carryover into the next separation. 
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6. The final separation results are displayed at the comple-
tion of the sequence. To view previous separations, select 
RESET to return to the MAIN screen.

7. Select FILE > OPEN to view previous separations. 
If a sample had multiple injections, the run sequence is displayed 
under a single name preceded by a “+” symbol. This symbol indi-
cates there are multiple injections with the same base file name. 
Names are appended with “-I(#)” to signify the numerical order of 
the separation. For example:

• If you have a single injection run, it can be named A01.

• For multiple injections, the first injection can be named 
A03-I1, the second can be A03-I2, and the third can be 
named A03-I3.

8. Select the file you want to display.

9. The remaining injections can be immediately viewed by 
pressing the left or right arrows at the lower left and right 
of the file viewer screen. This function can also be used to 
immediately view files before or after the currently viewed 
file even if they are not part of the same injection sequence.

Figure 3-3 Viewing injections

3.3.2 AutoInjection 
Operating Steps

This section outlines the steps performed by the AutoInjector 
during sample injection. 

1. You are prompted to place the sample probe into the sam-
ple container before the separation begins. 

2. During column equilibrium, the sample loop is first placed 
into the run position. This position passes the column 
equilibration fluid through the loop to wash out any left-
over fluid from a previous separation and fills the loop with 
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the initial gradient conditions from the current separation. 
This prevents any strong solvent remaining in the loop 
from affecting the current separation.

3. Near the end of the equilibration, the inject valve moves to 
the sample load position.

4. The AutoInjector Module aspirates enough sample to fill 
the loop with the programmed amount and to compensate 
for the volume of the sample probe. 

5. After the equilibration has completed, the injection valve 
moves to the separation position, and the separation pro-
cess continues.

6. After the first separation has completed, the next separa-
tion begins with the equilibration as described in steps 2–
5. During this process, the AutoInjector Module continues 
to aspirate the programmed injection volume.
When the sample is aspirated for the final injection of the 
sequence, the total volume of all the sample injections will 
match the programmed amount. 

· If the sample container held less sample than 
programmed, the final injection will aspirate a small 
amount of air. Small amounts of air will not damage 
the HPLC column. 

· If the sample container held more sample than 
programmed, there may be some sample remaining 
in the probe after the final injection. For this reason, 
we recommend programming the injection sequence 
with about 0.5 mL more sample volume than the 
actual sample amount provided in the sample. This 
will ensure all of your sample is processed. 

· If some sample remains in the sample probe (probe 
volume is approximately 0.43 mL), you can recover it 
by loosening the sample probe fitting at the injection 
valve to allow the sample to drain back into the 
sample container.

After completion of the final injection, the system washes the 
sample probe to prevent sample carryover during the next sepa-
ration. To perform the wash, the system will prompt you to follow 
the proper wash steps. 

The wash sequence proceeds as follows:

1. The system prompts you to place the probe in a strong 
wash solvent. This solvent should be capable of completely 
washing the sample from the probe.

2. 10 mL of strong solvent is aspirated through the probe to 
wash away any remaining sample from the probe.

3. The system prompts you to place the probe in a weak wash 
solvent.

4. 10 mL of weak solvent is aspirated through the probe to 
wash away any remaining strong solvent from the probe so 
that it cannot interfere with future separations. 
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3.3.3 Separation using an 
AutoSampler Module

Verify that the wash station contains fluid. If it doesn’t, go to 
TOOLS > AUTOMATION MANUAL CONTROL and select START WASH. 
After the wash station is primed, select STOP WASH. Verify that 
the wash fluid supply container has sufficient clean wash fluid 
for the planned separations.

In addition, if the separations will use a solvent bracketed 
injection, ensure there is sufficient bracket solvent for the 
planned separations. This solvent is placed into an 18 mm test 
tube located to the left of the wash station. The system uses 
about 100 µL per injection. The probe can only aspirate fluid 
down to the level of the top of the tube holder, so the tube 
must be filled to a level above that point. 

To begin a separation sequence with the AutoSampler Module, 
you can create a sample queue entry or, to start with a single 
sample, select START. Accessing the RUN tab results in a screen 
and operation much like the standard ACCQPrep without an 
installed AutoSampler Module. Selecting START opens the 
MINIMUM RUN REQUIREMENTS window. There, you can perform a 
manual injection by removing the Luer fitting from the inject 
loop, or you can perform multiple injections on a single sample 
from the AutoSampler module. A queue is created automatically. 
Selecting the QUEUE tab allows you to set up a separation 
sequence for multiple samples.

Note
If you are performing a manual injection, the Luer fitting or a 
needle port must be reinstalled on the injection valve.

3.3.4 Using the Dilute 
Sample Load Pump

Large samples, sometimes greater than a column volume, can be 
loaded onto columns using the ACCQPrep. Installation of the 
dilute sample loading pump is described on the instruction sheet 
accompanying the module. After it’s installed, follow the direc-
tions below to use the pump.

To prime the dilute sample load pump:

1. Make sure that your ACCQPrep HP150 is primed.

2. Place the dilute sample load pump’s inlet line into a weak 
solvent.

3. Verify that the sample load pump’s valve is set to RUN.

4. Place an empty syringe on the prime port, then open the 
prime port by turning it counterclockwise.

5. Press the P button on the pump while drawing air out of 
the system (Figure 3-4). Repeat until no more air is drawn 
via the syringe

6. Turn the prime valve clockwise until closed, and press P to 
stop priming. 



ACCQPrep HP150 
Section 3   Operation

3-8 EAR99 Technology Subject to Restrictions Contained on the Cover Page

Figure 3-4 Loading Pump P button

The dilute sample load pump can be ran manually through the 
pump face interface or set up to run automatically (with user 
prompts) with a programmed volume and flow rate. With the 
manual valve, you do not need to be present for user-prompted 
action to turn the valve as needed.

To avoid issues of clogging the lines of the system and pump lon-
gevity, properly filtering the sample before loading it is strongly 
recommended. This will also help extend the life of your column.

When you are ready to inject:

1. Ensure that the dilute sample load pump is primed as 
described above.

2. Place your sample in the cartridge or the inlet line (or 
syringe with sample) into a vessel with your sample.

3. Select the START button on the MAIN screen. The SAMPLE 
OPTIONS window (Figure 3-5) opens above the MINIMUM 
RUN REQUIREMENTS window.

4. Choose “Large Sample.” Select other parameters, then 
select OK to dismiss the SAMPLE OPTIONS window.

5. Choose your parameters on MINIMUM RUN REQUIREMENTS 
window, then select START EQUILIBRATION.

6. When the equilibration is started, the LARGE SAMPLE 
INJECTION window (Figure 3-6) appears to allow observa-
tion of the baseline, adjust flow rates, and to provide a 
means to stop loading after the sample saturates the col-
umn.
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Figure 3-5 Dilute Sample Loading Pump Automatic 
Loading window

Figure 3-6 The Large Sample Injection window

By default, the flow rate is the same as that for the column. 
However, the HPLC pumps can also be run at a different 
flow rate to provide a desired solvent composition to pre-
vent phase collapse on the column or to prevent the sample 
from precipitating.

• AUTO ZERO – Zeros the detector before starting the 
separation.

Pump control options:

• FLOW RATE – Type or select the pump’s flow rate in 
mL/min.
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• PUMP VOLUME – Type or select the pump’s volume in 
mL, or choose UNLIMITED.

· UNLIMITED – The pump runs until you stop it. The 
pumps can be restarted to allow for flask washings to 
be loaded.

The main pumps can also be run from this window. Run-
ning 5% B solvent can be useful for preventing phase col-
lapse when working with aqueuous compounds.

• CONTINUE WITH SEPARATION – Notifies you that the 
gradient and peak detection parameters can be changed 
before starting the run. Afterward, you may CONTINUE.

• CONTINUE – Starts the purification.

• CANCEL – Stops the purification.

3.3.5 Using the Queue Tab Sample queues are lists of samples, purification methods, 
detection parameters, and injection instructions to run in 
sequence. The queues can be appended with samples and saved 
for running later. Saved queues are also used for scheduled oper-
ations (Section 2.5).

Creating a sample queue To create a sample queue, an AutoSampler or AutoInjector must 
be installed.

1. Install a sample vial rack before opening the QUEUE tab. 
This allows the software to limit sample programming to 
the positions available for sample vials. 

2. Select the QUEUE tab at the bottom of the MAIN screen 
(Figure 3-7).

3. Do any of the following:

· Select an empty row to create a sample entry. A new 
row is populated with the COLUMN and its default 
METHOD displayed on the MAIN screen.

· Select a sample to edit its column entries. (See 
Section 3.3.6 for a detailed discussion of the QUEUE 
tab’s column options.)

· Populate the tab with samples that you have earlier 
saved to a file using the IMPORT SAMPLE LIST INTO 
QUEUE button (described below).

4. (Optional) The samples list can then be exported to a plain 
text file (.txt) for future use by selecting EXPORT COL-
UMN/METHOD LIST. Later, you can IMPORT SAMPLE LIST 
INTO THE QUEUE to populate the QUEUE tab.

Running a sample queue Because sample queues allow the system to run unattended for 
extended time periods, you should verify that the system is ready 
to run the samples that will be in the queue. Although the 
ACCQPrep system will stop the pumps for situations such as 
empty solvent bottles, a filled waste container, or when all 
fraction containers used, no samples will be run until the con-
dition stopping the run is resolved. Make sure that the sample is 
in the correct position in the rack and that the vial cap is 
removed
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To run a queue, do one of the following:

• Select the RUN tab, then select START.

• Select the “≡” menu on the first unfinished run, then 
select START RUN.

In either case, MINIMUM RUN REQUIREMENTS opens. Accept or 
modify the starting rack or tube for fraction collection.

While a separation is in process, the QUEUE tab can be accessed 
to add samples to the queue. Samples that have been completed 
cannot be edited. However, they can be viewed by touching the 
sample name corresponding to that run. 

To perform continuous separations, during the separation 
remove completed fraction racks when full and replace with 
empty racks.

If a single rack containing fractions is removed and then 
replaced into the rack position, PeakTrak displays a 
prompt to determine if the rack contains empty tubes.

a. If you respond that the tubes are empty, PeakTrak con-
siders this rack available for future separations.

b. Otherwise, PeakTrak continues to mark this rack as 
full of samples and not available for fraction use.

This feature allows you to remove a rack to obtain a sam-
ple for verification while leaving the rack in the instru-
ment for convenience and later removal.

After the entire queue has completed, a RESULT window is dis-
played showing the last separation.

To view completed separations, do one of the following:

• Select the separation on the QUEUE tab

• Select FILE > OPEN to view previous separations.
If a sample had multiple injections, the run sequence is displayed 
within the FILE > OPEN dialog under a single name preceded by a 
“+” symbol. This symbol indicates there are multiple injections 
with the same base file name. Names are appended with “-I(#)” to 
signify the numerical order of the separation. 

For example:

• If you have a single injection run, it can be named A01.

• For multiple injections, the first injection can be named 
A03-I1, the second will be A03-I2, and the third will be 
named A03-I3, etc.

AutoInjector Sample queues can also be used with the AutoInjector. Although 
only one sample can be run in a single queue in a system without 
an AutoSampler, the queue is useful to test several columns 
without user intervention on systems equipped with column 
switchers. The columns can also be tested periodically to 
determine if they have deteriorated. Also, the NO INJECT/NO 
COLLECT toggle in the METHOD EDITOR can be used to wash all 
the columns at the end of the workday. This removes strongly 
retained compounds and washes buffers and solvent modifiers 
from the system.
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Other queue operations To reuse an existing run: On the QUEUE tab, open the run you 
want to reuse (FILE > OPEN). A RUN window opens. Select 
EXTRACT to add this column and method to the end of the queue 
on a new line.

To calculator a Focus Gradient: With the QUEUE tab selected, 
open the scouting run that you want to focus. Select FOCUS GRA-
DIENT to create a focused gradient. The new gradient method 
appears on a new row in the queue.

3.3.6 The Queue Tab

Figure 3-7 Automation Queue tab 

The queue is a list of samples to be run in the order listed. Create 
new entries on the QUEUE tab by touching to add a row, then by 
editing the fields under each column. Each row represents a 
sample.

To save a file for future use, select FILE > SAVE QUEUE AS.

To open a saved queue, select FILE > OPEN. The FILES window 
appears. Select QUEUE FILES (*.queue) as the FILE TYPE so that 
only queue files are displayed. Select the file you want, then 
select OPEN to load the queue to the QUEUE tab.

Note
The number of rows in the queue is limited to 28. Additional 
samples can be added by deleting completed rows from the 
queue. If there are more rows than can be displayed on 
screen, up and down arrows that access hidden rows are dis-
played at the top and bottom of the screen.
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≡ – A menu to edit a sample. Menu options only apply to the row 
from which they are chosen.

• START RUN or RUN NEXT starts the separation. RUN 
NEXT starts a separation regardless of its order in the 
queue.

• REMOVE ROW removes the row from the queue. 

• ENABLE or DISABLE POST-SEPARATION PAUSE.

· ENABLE causes the system to pause the run and 
allow detection parameters, gradient method, or 
injection volume to be changed to optimize the purifi-
cation.

· You can also DISABLE the pause for the remaining 
injections, or leave it enabled to allow a second 
condition scouting separation.

· Rows with enabled post-separation pauses are 
highlighted yellow.

• MOVE to QUEUE FOR LATER from the QUEUE tab (Section 
3.3.7) for later use.

Sample Name – The name of each sample. Naming is optional. 
If left blank, the sample is named after the date and time the 
separation was started.

Column (dropdown menu) – I f  a Column Selector Valve 
Module (CSV-4) is installed, this is list of separation columns and 
associated methods. If a CSV-4 is not installed, this lists different 
methods that may be associated with the configured and 
installed separation column. 

Method – The methods that were defined for column configu-
ration are displayed. After a column has been selected, or if there 
is only one column defined on the system, the default method 
created for that column is automatically loaded.

To change this method, select the method name. A list of 
methods associated with the column appears. These meth-
ods are listed in the order they were created. Alternatively, 
select CUSTOMIZE CURRENT METHOD or BROWSE to popu-
late this field. 

To modify a method, select a method on a row to modify 
and select CUSTOMIZE CURRENT METHOD to open the 
METHOD EDITOR. There, the gradient and detection param-
eters can be changed.

To use the modified method, exit the METHOD EDITOR
and select SAVE when prompted. This creates a new 
method named “Temporary 1” that will be used for all 
injections of the current sample, then discarded after the 
sample is complete. All method parameters are saved with 
each separation.

To save the modified method for later use, select 
SAVE AS before you exit the METHOD EDITOR, then create a 
unique name for the new method.
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Sample Position – The location of the sample for this sepa-
ration. If the sample size is too large for a single vial, create a 
second line in the queue and access the second vial.

Sample Volume – The amount of sample to be separated. Typi-
cally this amount is slightly greater than the amount of sample 
to ensure all of the sample gets purified. This information is used 
in conjunction with the NUMBER OF INJECTIONS column to cal-
culate the volume of each injection. 

Number of Injections – Used in conjunction with the SAMPLE 
VOLUMES column to determine the size of each injection. 

Start Tube – NEXT TUBE uses the next available tube in the 
current fraction collection rack, while NEXT RACK starts a new 
rack, if available. You can optimize rack usage by sharing racks 
for multiple samples or optimize the work flow by placing each 
sample’s fraction into individual racks to support multiple users.

Export Column/Method List – Exports the samples list to a 
plain text file (.txt) for future use.

Import Sample List Into the Queue – Populates the QUEUE
tab with a method list previously saved using EXPORT 
COLUMN/METHOD LIST.

3.3.7 The Queue for Later 
Tab

Figure 3-8 Queue for Later

This is similar to the QUEUE tab (Section 3.3.6), allowing you to 
add samples to the system. As in the QUEUE tab, these queues 
can be saved (FILE > SAVE QUEUE AS). But this tab differs from 
the QUEUE tab in important ways:

• Samples cannot be run from this tab directly; instead, 
you can get methods ready and run them when the 
sample is ready. 

• You can MOVE TO QUEUE from the QUEUE FOR LATER 
tab. The row moves to the bottom of the list on the 
QUEUE tab.

3.3.8 AutoSampler Injection 
Techniques

This  sec t i on descr ibes  operat ing protoco l s  for  the 
AutoSampler Module.

Note
The sequence of operation described below is valid for soft-
ware versions starting with 4.1.13. 

The AutoSampler supports two different injection protocols. The 
default technique injects samples and washes the sample probe 
using the wash station solvent. The alternative bracketed sample 



ACCQPrep HP150 
Section 3   Operation

3-15EAR99 Technology Subject to Restrictions Contained on the Cover Page

injection minimizes the risk of sample crash by placing a small 
amount of a user selected solvent on each end of the sample fluid. 
All sample injection steps are listed below for reference:

Default Injection Sequence 1. During column equilibrium, the sample loop is first placed 
into the run position. This position passes the column 
equilibration fluid through the loop to wash out any left-
over fluid from a previous separation and fills the loop with 
the initial gradient conditions from the current separation. 
This prevents any strong solvent remaining in the loop 
from affecting the current separation.

2. The sample probe is placed in the wash station.

3. About 1.5 mL of the solvent is pulled from the wash station 
through the probe to remove air from the probe line. 

4. The sample probe is lifted from the wash station and is 
moved up and down slightly. When the sample probe is 
dipped in the sample or solvent, some liquid sticks to the 
outside of the probe when it is raised. For that reason, the 
probe is moved up and down over the fluid source to shake 
off any excess liquid and to prevent the contamination of 
other samples or collection tubes. 

5. A small amount of air (0.05 mL) is drawn into the sample 
probe to minimize the mixing of the wash solvent and the 
soon to be loaded sample. This also minimizes the potential 
of the sample coming out of solution. 

6. The sample probe is moved to the sample container.

7. A portion of the programmed injection amount is aspirated 
into the sample probe displacing most of the wash solvent 
in the sample probe. This compensates for the volume of 
the sample probe. Since the loop is still in the separation 
position, the wash solvent is sent to waste.

8. The loop is switched to the load position.

9. The remaining portion of the programmed injection volume 
is aspirated into the sample probe and loop. After the pro-
grammed amount of sample is aspirated into the probe, the 
probe is lifted out of the sample vial. 

10. The probe is moved up and down over the sample tube to 
shake off any excess liquid to prevent the contamination of 
other samples or collection tubes.

11. The probe is dipped into the wash station to rinse the exte-
rior of the probe to prevent sample residue from drying on 
the exterior of the probe.

12. Air is drawn into the sample probe to draw the remaining 
sample into the loop without leaving any sample in the 
probe. 

13. The sample is now loaded and the separation begins.

14. The next injection of the sample is accomplished by repeat-
ing the process described above. 

After the completion of the final injection of a sample, the system 
washes the probe in the following sequence:
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1. The inject valve is moved to bypass to prevent contamina-
tion of the loop during the cleaning process. 

2. Air is drawn into the probe to eliminate any remaining sol-
vent in the probe.

3. The probe is placed into the wash station. The wash station 
pump flushes wash fluid over the exterior of the probe 
while 10 mL of wash fluid is drawn into the probe to wash 
the interior flow path. The probe syringe pump uses half 
strokes to improve the rinsing of any tiny amounts of com-
pound that may be present due to the wash process. Once 
again, the probe is moved up and down over the wash sta-
tion to shake off any excess liquid and to prevent the con-
tamination of other samples or collection tubes. 

4. Air is drawn into the probe to eliminate the strong wash 
solvent from the sample flow path. 

Bracketed Sample 
Injection Sequence

1. During column equilibrium, the sample loop is first placed 
into the run position. This position passes the column 
equilibration fluid through the loop to wash out any left- 
over fluid from a previous separation and fills the loop with 
the initial gradient conditions from the current separation. 
This prevents any strong solvent remaining in the loop 
from affecting the current separation.

2. The sample probe is placed into the wash station

3. About 1.5 mL of the solvent is pulled from the wash station 
through the probe to remove air from the probe line. This 
minimizes injection volume errors due to air in the probe. 
Since the loop is still in the column flow path, this aspi-
rated fluid bypasses the loop and is sent to waste

4. The sample probe is lifted from the wash station and is 
moved up and down slightly. When the sample probe is 
dipped in the sample or solvent, some liquid sticks to the 
outside of the probe when it is raised. For that reason, the 
probe is moved up and down over the fluid source to shake 
off any excess liquid and to prevent the contamination of 
other samples or collection tubes.

5. A small amount of air (0.05 mL) is drawn into the sample 
probe to minimize the mixing of the wash solvent and the 
bracket solvent.

6. The probe moves to the bracket solvent sample station 
(just to the left of the wash station). 0.05 mL of the bracket 
solvent is aspirated into the probe. 

7.  The probe is raised into the air and an additional 0.05 mL 
of air is aspirated into the probe. 

8. The sample probe is moved to the sample container.

9. A portion of the programmed injection amount is aspirated 
into the sample probe displacing most of the wash solvent 
remaining in the sample probe. This compensates for the 
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volume of the sample probe. Since the loop is still in the 
separation position, the wash solvent is sent to waste.

10. The loop is switched to the load position.

11. The programmed injection volume is aspirated into the 
sample loop. After the programmed amount of sample is 
aspirated into the probe, the probe is lifted and a small 
amount of air is drawn into the sample probe. This mini-
mizes mixing of the sample with the bracketing solvent, 
which is aspirated next

12. The probe is dipped in the wash solvent to rinse the exte-
rior of the probe, then raised and shaken. This minimizes 
sample contamination of the bracket solvent.

13. The probe moves to the bracket solvent sample container. 
(0.05 mL of the bracket solvent is aspirated into the probe.)

14. The probe is raised into the air and the fluid in the loop is 
aspirated into the loop along with about 0.05 mL of air to 
ensure all of the sample and bracket solvent is loaded.

15. The loop is switched to the separate position.

16. The sample is now loaded and the separation begins.

17. The next injection of the same sample is accomplished by 
repeating the process described above.

After the completion of the final injection of a sample, the system 
washes the probe with the following sequence:

1. The inject valve is moved to bypass to prevent 
contamination of the loop during the cleaning process.

2. Air is drawn into the probe to eliminate any remaining 
solvent in the probe. 

3. The probe is placed into the wash station. The wash station 
pump flushes wash fluid over the exterior of the probe 
while 10 mL of wash fluid is drawn into the probe to wash 
the interior flow path. The probe syringe pump uses half 
strokes to improve the rinsing of any tiny amounts of com-
pound that may be present due to the wash process.

4. Once again, the probe is moved up and down over the wash 
station to shake off any excess liquid and to prevent the 
contamination of other samples or collection tubes.

5. Air is drawn into the probe to eliminate the strong wash 
solvent from the sample flow path. 

3.3.9 Fraction Collection 
with the AutoSampler

The fraction collection racks in the AutoSampler double or triple 
the fraction collection ability of the ACCQPrep. They are treated 
as an extension of the racks present in the ACCQPrep. In 
general, if racks are placed in both the ACCQPrep  and 
AutoSampler 2x2, available racks are used in the following order:

1. ACCQPrep left rack (A),

2. ACCQPrep right rack (B),

3. AutoSampler left rack (C),

4. AutoSampler right rack (D).
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If racks are placed in both the ACCQPrep and AutoSampler 4x2, 
available racks are used in the following order:

1. ACCQPrep left rack (A),

2. ACCQPrep right rack (B),

3. AutoSampler center left rack (D),

4. AutoSampler center right rack (E),

5. AutoSampler right rack (F).
If any racks are missing or identified as containing fractions 
from a previous separation, the system moves to the next 
available rack in the order listed above.

When the system moves from the ACCQPrep fraction racks to 
the AutoSampler fraction racks, the fluid uses an alternative 
path. This leaves a portion of tubing with fluid remaining for the 
fraction collector previously used. To prevent loss of any com-
pound, the software monitors for a portion of the separation with 
no peaks while using the last available row of the fraction col-
lection rack on that module. If a portion without a peak to collect 
is identified, the system moves to the next rack on the next 
module (the AutoSampler or ACCQPrep). This may leave a few 
tubes unused in the previous rack. If the system is mid-peak or if 
the separation is set to Collect All, the fluid remaining in the 
tubing is placed into one of the tubes in the last row of the rack 
before the move to collect any undetected compound. Then the 
system advances to the next rack.

Funnel Racks - If a funnel rack is detected, you can set it up to 
collect into larger containers.

3.3.10 Stacked Injections With PeakTrak v4.3.4 or greater, injections can be “stacked;” that 
is, multiple injections can be injected after each other during the 
same isocratic run. Stacked injections save time and solvent by 
reducing non-elution phases of the run and maximizing the 
column bed capacity. Methods suitable for stacked injection 
require a short isocratic method with all peaks eluting in close 
proximity. Although commonly applied to chiral compounds, this 
feature is useful for achiral purifications as well. Also, stacked 
injections allows the use of smaller, less expensive columns by 
maximizing the efficiency of the entire column bed by quickly 
performing multiple smaller injections versus larger single 
injection runs with larger capacity columns. 

Procedure The Focus Gradient Generator is used to calculate an isocratic 
method, which is used to determine the cycle time and the time 
windows for peak collection. These are used to run stacked injec-
tions.

1. Create an isocratic run, or use the Focus Gradient Genera-
tor to calculate an isocratic method from it. (See 2.4.4  Cre-
ating Scouting and Focused Gradients)

Note
Verify that there are no impurities eluting after the desired 
compound(s).
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a. Start with a scouting gradient run either from analyti-
cal HPLC data or from scouting data from an 
ACCQPrep HPLC system.

b. Select FOCUS GRADIENT on a RUN VIEWER window to 
open the FOCUS GRADIENT GENERATOR.

c. Calculate the purification method:

· Select a column.

· Select the peak of interest.

· Set the FOCUS RANGE to +/- 0% ISOCRATIC.

d. Select FOCUS to close the window. A method is gener-
ated and displayed on the MAIN screen. 

e. Delete the two step gradient points at the end of the 
run to create an isocratic method. (The software will 
not be able to create a stacked injection unless the gra-
dient run is completely isocratic.)

f. Select START to start the run. The MINIMUM RUN 
REQUIREMENTS and SAMPLE OPTION windows open.

2. Create the collection time windows 

a. Select EXTERNAL SAMPLE on the SAMPLE OPTIONS win-
dow.

· For systems equipped with an AutoSampler, 
disconnect the sample probe at the injection port and 
replace it with the AutoInjector probe 
(PN 60-5234-657).

· No probe change is needed for units with only an 
AutoInjector.

b. Select POST-SEPARATION PAUSE between injections so 
that adjustments to the gradient or injection volume 
can be made without configuring the system for an 
entirely new run.

c. Enter the TOTAL SAMPLE and an INJECTION VOLUME.

d. Select OK to close the SAMPLE OPTIONS window and 
reveal the MINIMUM RUN REQUIREMENTS window.

e. Check solvent amounts; if these are acceptable, select 
START EQUILIBRATION. A Run window opens after the 
run is finished.

f. Select PEAKS on the RUN VIEWER window. Detected 
peaks are used to determine the initial time windows.

g. If needed, EDIT INJECTION and EDIT METHOD to adjust 
the injection volume or the solvent composition.

h. Select STACK INJECTIONS on the RUN VIEWER window. 
The STACKED INJECTION window opens. The system dis-
plays a simulated stacked injection based on the isocra-
tic run. The time windows displayed are based on the 
isocratic peak collection. 

i. Adjust STACKED INJECTION settings as required. If no 
peaks were collected during the isocratic run, time win-
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dows will not be displayed, but you can add them there 
manually. See The Stacked Injection window below for 
more information.

3. Prepare to run the stacked injections.

a. Verify that there is enough solvent (as listed on the 
MINIMUM RUN REQUIREMENTS window).

b. Verify that the waste container is empty.

c. Confirm that the sample is in place.

d. Run the stacked injections by selecting OK on the 
STACKED INJECTIONS window.

Exiting the STACKED INJECTIONS window brings you back to the 
MAIN screen. If you select the TERMINATE button at MAIN, 
PeakTrak offers you the option to continue or terminate the run, 
or to cancel:

• STOP INJECTING AND CONTINUE RUN stops any further 
injections from occurring but allows any injections that 
are still in the column to finish. The probe wash 
procedure is implemented to clean sample from the 
probe.

• TERMINATE RUN NOW immediately ends the run. Sample 
may be left in the injection loop and on the column; this 
will eventually need to be washed out of the column. As 
with STOP INJECTING, the probe wash procedure runs.

• CANCEL continues the current purification.

Figure 3-9 Stopping stacked injections

The Stacked Injection 
window

The chromatograph displays a simulated stacked injection chro-
matogram based on the isocratic run created previously. Each 
band's color corresponds to a different injection. Crosshatching 
denotes different time windows. As on the MAIN screen, you can 
ZOOM IN and MODIFY VIEW.
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Figure 3-10The Stacked Injections Window

Show Single Injection – Shows a single injection on the chro-
matogram. This view is useful for adjusting the time windows. 
For example, adjusting the time window to appear a bit larger 
than the collected peak can maximize sample recovery by col-
lecting the peak’s tail.

Cycle Time – A time in minutes. Displaying the set of three sim-
ulated injections allows a visual determination of the proper 
cycle time. When peak widths are adjusted, the Cycle Time will 
likely need to be changed also so that there is a small gap 
between the collection windows.

Total Sample – A sample volume in mL.

Injection Volume – By default, the value used from the last iso-
cratic injection prior to entering the Stacked Injection window. 
Verify that this is the total volume of the sample before selecting 
OK.

Fraction Pooling – Collects corresponding peaks in the same 
container. This is the default. Use the largest containers prac-
tical to minimize the number of fractions. Fraction Pooling 
interacts with Collection to determine peak collection behavior, 
as summarized in Table 3-1

Time Window entry – Select ing a row enables  that time 
window. Disabling a time window turns off peak collection during 
that time, whether a peak is present or not. This allows impu-
rities to be ignored.

Start  – The start of the time window in minutes.

End – The end of the time window in minutes. 
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Collection – Determines which peaks are collected, if any. Col-
lection interacts with Fraction Pooling to determine peak col-
lection behavior, as summarized in Table 3-1.

3.4 Operation 
Troubleshooting

Injection Valve Leak- refer to on rotor replacement if 
needed – (See Section 5.5.1 for more information)

• Failure to filter the sample can allow particles to scratch 
the valve sealing surface.  Filter the sample with a 
20 µm or finer filter.

• Dissolve sample in sufficient solvent so that evaporation 
of solvent doesn’t cause formation of crystals

• Manual injection using a hypodermic needle with 
pointed tip can scratch the internal sealing surface 
resulting in leaks.  When using a needle injection port 
only use a 22 gauge blunt tip needle.  When using a Luer 
injection port, only use a Luer syringe tip.

• If performing manual injection, ensure that a check 
valve is mounted downstream of the injection valve to 
prevent solvent from dripping when the syringe is 
removed.

• If an automated injector is installed and the waste 
connected to other waste lines with a tee, ensure a check 
valve is installed in the injection pump waste line.

• Formic acid modifiers can result in reduced injection 
valve seal lifetime.  If possible, consider other modifiers 
such as TFA.

• 100% water as a chromatographic solvent can also 
reduce seal lifetime. 

Unexpected retention time or variable retention times for 
repeated injections – 

• Temperature variation of only a few degrees can cause a 
visible retention time shift.

• Variable flow rates of the A or B solvent:

· Check valves may require cleaning or replacement 
due to contamination from solvents or pump seal 
wear particles.

Table 3-1  Time window collection

Fraction Pooling on Fraction Pooling off

Peaks Only the first detected peak is 
collected. Everything else 
diverted to waste.

Detected peaks collected in dif-
ferent containers. Non-peak 
eluant diverted to waste. 

All No peak detection. Everything 
within the time window col-
lected into the same container.

Peak detection is enabled. 
Peaks in different containers. 
Non-peak eluant collected as 
fractions.
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· Inadequate priming of the pump may cause the A or 
B solvent to flow at lower rates. This may be due to 
sticking check valves. Open the front panel and tap 
the check valves with a wrench while priming to 
assist in bubble passage through the pump.

· Solvent supply fitting may be loose, allowing small 
amounts of air into system, and causing minor flow 
rate errors of A or B solvent.

· Strong solvent used for injection (if the repeated 
injection is a larger volume).

• Solvent bottle refilled with incorrect solvent.

No peaks on chromatogram – 

• No sample injected:

· Sample vial empty.

· Sample probe plugged, injection loop plugged, or 
probe or injection pump fitting loose.

· Perform a dummy injection and watch the 
injector pump to determine if fluid is being 
aspirated. Disconnect tubing at different 
points and place it into fluid to determine 
the location of the problem.

· If the fitting is loose, tighten or replace it as 
needed.

· If the probe is plugged, replace that part or 
connect it to a high pressure pump to 
dislodge the plug.

• Incorrect wavelength used (assuming no other detectors 
than UV/UV-vis).

• Compound doesn’t absorb light.

• B solvent not being delivered.

· Check solvent level, connections, and check valves.

· Confirm that solvent lines are in correct bottles.

· Check for leaks.

• Solvent gradient method is too weak to elute the sample.

• Leak in system is preventing fluid from reaching the 
detector.

• UV or UV-Vis detector not functioning (the baseline is 
completely flat with no visible noise.

· Liquid due to immiscible solvents could be trapped in 
the detection gap. When changing from normal to 
reverse phase, flush the system with an intermediate 
solvent miscible with both phases such as isopro-
panol, or flush the system when changing phases in 
order of polarity. 

· Flow cell detection gap obstructed. Remove the flow 
cell from the system and view through the liquid 
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path. The detection rods should be visible with a 
small gap between the rods.

· This is not a lamp or detector hardware problem. 
These failures have corresponding error messages.

Peaks elute too early – 

• Solvent A not being delivered properly.

· Check the solvent level.

· Inspect or clean the pump A check valves.

· Confirm that the solvent lines are in the 
correct solvents.

· Look for leaks of air into the lines.

• Sample is injected in a strong solvent that carries the 
sample down the column.

• Column is not suitable for the compounds separated.

• Fungal or bacterial growth could be obstructing the inlet 
filters or effecting the check vales in pump A. Use an 
additive such as 5% B solvent in the A solvent to prevent 
any growth. Be sure to change the aqueous solvents 
frequently. 

• Incorrect method used.

Peaks elute too late – 

• Solvent B not being delivered properly.

· Check the solvent level.

· Inspect or clean the pump B check valves.

· Confirm that the solvent lines in the correct 
solvents.

· Look for leaks of air into the lines.

• Check for proper flow rate of both solvents. If flow of one 
of the solvents is only half of the expected flow, prime 
the system again since one of the pump heads isn’t 
primed. If this is unsuccessful, open the front cover and 
tap on the heads of the problem pump.

• Column is not suitable for the compounds separated.

• Incorrect method used. 

Poor peak shape – 

• Solvent modifier needed for sample.

• Sample injected in strong solvent.

• Column (or guard column) has voids (or other damage, 
such as loss of bonded phase). 

“Phantom” or “Ghost” peaks  – Sometimes peaks appear as a 
broad peak in an area of sharp peaks.

• Wash the column with strong solvent. 
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• May be caused by a compound left from a prior injection

· Ensure that the gradient goes to 100% B in 
each separation to ensure all compounds are 
washed from the column.

• Impurities in solvent

· Evaluate with runs with no sample injection 
to determine if impurity is from the sample. 
Make a run with a standard injection 
volume, then double the equilibration time. 
If the peak in question become larger, it is 
solvent related. Check mobile phase quality, 
check for fungal or bacterial growth, or 
ignore the peak. 

Drifting baselines – 

• Mobile phase absorbance, which may be caused by an 
impurity in the solvent or a solvent modifier.

• Column not equilibrated; increase the equilibration time 
to determine if this solves the problem.

• A compound from a previous run was not fully washed 
from the column and is slowing coming out of the 
column. Wash the column with strong solvent to 
eliminate compounds from prior separations. 

ELSD detection issues – 

• No peaks detected

· If the compounds are volatile, they may not be 
detected by ELSD or may need a lower drift tube 
temperature. Refer to the discussion on ELSD 
operation in section 4.3.4 before adjusting the ELSD 
operating temperatures.

· If the system detects peak shortly after the first 
separation of the day and then fails to detect, the 
drift tube temperature may be too low to vaporize the 
solvent aerosol or the spray chamber too warm to 
condense out excess higher boiling point solvents.  
Refer to the discussion on ELSD operation in Section 
4.3.4 before adjusting the ELSD operating tempera-
tures.

· Verify that the P-trap contains fluid. If using reverse 
phase solvents with recommended conditions there 
should be a small amount of fluid draining from the 
P-trap. Fill the P-trap if needed.

· Increase ELSD SENSITIVITY and SIGNAL GAIN in the 
METHOD EDITOR to see if the peaks are simply too 
small to be easily seen.

· Flow splitter tube blocked. This 0.005" ID red colored 
tubing may be plugged by sample. Remove the tubing 
from the nebulizer during operation to verify flow 
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through the tubing. If it is plugged, replace both 
segments of tubing.

• Weak UV or ELSD peaks

· Each detector has a different response to compounds 
and may be more or less sensitive to compounds than 
the other detector.

· Semivolatile compounds may be difficult to detect or 
may benefit from modification of the ELSD sensi-
tivity, gain, or operating temperatures. Refer to the 
discussion on ELSD operation in Section 4.3.4 before 
adjusting the ELSD operating temperatures.

· Check the P-trap. (see discussion on “No Peaks 
Detected.”)

• UV and ELSD signals aren’t aligned in time.

· The peak widths or shapes of the two signals may 
vary because of varying sensitivity of the two 
detectors causing the alignment to appear incorrect.

· If the signals sometimes appear a few seconds out of 
alignment, it could be normal due to different peak 
shapes common with ELSD.

· Partial blockage of the ELSD 0.005" red split tubing 
could reduce flow to the ELSD, causing the ELSD 
signal to lag the UV signal.

• UV or ELSD peaks are broader than the other detector.

· This is normal due the detector response and a small 
increase in dispersion in the alignment compensation 
tubing. 

PurIon detection problems – 

• Little or no mass spectrum detected on method devel-
opment screen, but compound should be visible.

· Sample is dissolved in a solvent not suitable for MS 
injection such as DMSO or DMF. Dissolve in 
methanol or acetonitrile and try again.

· Try other ionization parameters, such as switching to 
“Robust.”

· Verify that the gas supply is functioning. Small peaks 
may be visible without the gas. Nitrogen is typically 
used.

· Make sure the proper gas is supplied. Argon causes 
arcing that results in noise.

· Fluid interface carrier solvent bottle empty. 

• MS peaks occur later than peaks from the other detector 
such as UV.

· The MS carrier fluid flow rate is too low.

· Be sure that the fluid interface priming port is fully 
closed.
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· Check the carrier pump seals for leakage.

· Clean or replace the carrier pump check valves. 

Excessive system pressure – 

• If using a Column Select Valve Module (CSVM) make 
sure the column is connected properly. (If the column 
output goes to the wrong port, it is dead-ended.)

• Column getting clogged:

a. Remove guard column (if installed) and check back 
pressure. If this corrects the problem, replace the guard 
column or following the washing procedure below.

b. Remove preparative column and check back pressure.

c. If the column is clogged, try flushing with stronger sol-
vent than mobile phase. (This procedure may damage 
polymeric reverse phases.) A flush protocol could 
include 100% MeOH or ACN without buffers or modifi-
ers followed by 100% DCM, then followed by 100% hex-
anes. Reverse the order of solvents to get back to 100% 
ACN or MeOH.

d. Reverse the column connections and flush.

e. Place the column outlet (which was originally the col-
umn inlet) over a beaker so any particles that are 
flushed out don’t get into the system.

f. Filter samples in the future to prevent problems. 

Fractions not correct volume – 

• Air trapped in pump head:

· Reprime and test again.

· COLLECT ALL with 100% A and 100% B. If only one 
solvent shows half-filled fractions, one of the heads is 
not priming. Remove the front panel and loosen the 
fitting of each individual head while running the 
pumps under manual control.

• Air leak in inlet lines:

· Remove front panel and examine inlet lines while 
operating. If small air bubbles exist, follow tubing 
back to source, examining for source of air bubbles. 

Injection valve dripping – 

• Valve rotor is damaged by particulates in the flow 
stream or from injected sample.

· Remove the injection valve stator using a 9/64" hex 
wrench. (The stator is the part with the tubing 
connections.) The rotor can be lifted out with a 
fingernail and replaced (PN 20-9009-917). Inspect 
the face of the stator for scratches. In rare cases, the 
stator must also be replaced (PN 20-9009-919).
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ACCQPrep HP150

Section 4  PeakTrak

4.1 Overview PeakTrak is the software that controls the ACCQPrep. This 
section discusses the basic functionality of PeakTrak when 
operated via the touchscreen or a remote browser window.

4.1.1 PeakTrak Window 
Elements

The MAIN screen displays the current METHOD FILE. From MAIN, 
you can access many of PeakTrak’s features, view the system 
status, and view or edit the method file settings. These are the 
elements of the MAIN window:

Menu  – The topmost item in the window is the PEAKTRAK 
MENU from which you can access all of PeakTrak’s features. For 
more information, see Section 4.2  PeakTrak Menu Options.

System Status  – Displayed to the right of the Menu. Status 
messages may include:

· system mode

· current position in a run, expressed in time or 
column volumes

· current %B

· flow rate
Main Region – Where method file settings can be viewed or 
modified. Frequently used method settings are displayed on the 
MAIN screen, while advanced method options are set on the 
METHOD EDITOR window. See Section 4.3.1  The Main Screen.

Many of the PEAKTRAK WINDOWS contain these main elements or 
a subset of them (Figure 4-1).



ACCQPrep HP150 
Section 4   PeakTrak

4-2 EAR99 Technology Subject to Restrictions Contained on the Cover Page

Figure 4-1 The Main screen

Note
The available commands and options will change according to 
the active window, the state of the system, and the current file.

4.1.2 Method Files PeakTrak controls the separations performed by the system 
through a METHOD FILE. You do not have to create a complete 
method to perform a separation. When the system is turned on, it 
associates a default method in the system with the column 
selected as a default in the CONFIGURATION screen. In a single 
column system, this reflects the column mounted on the system. 
This default method is stored on the system hard drive, and a 
copy of it is automatically loaded into a temporary use area.

If the default method meets your needs, select START to start a 
separation. On the other hand, if you want to customize the 
method for use on this separation only, edit the method. (You can 
edit the gradient by dragging a gradient point is a commonly 
used modification.) This modified gradient will be used for the 
separation. This method is not saved for later reuse unless you 
select FILE > SAVE METHOD > and name the method. If you didn’t 
save the method, but you later want to reuse it, open a data file 
that used the method and extract it for reuse. The system uses 
the method file in the temporary area to direct the system oper-
ation after you select START.

PeakTrak categorizes the method settings as Basic or Advanced. 
Basic settings are the frequently used controls accessed through 
the MAIN screen. Use the METHOD EDITOR window to access the 
advanced settings.
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Method files are stored by the system and can be opened for 
review, reuse, or modification. To open a method file, select FILE 
> OPEN. Method files can be transferred to the system from an 
external storage device using FILE > IMPORT METHOD. Method 
files have an *.pmtd filename extension.

Default Methods When PeakTrak is started, the system loads a default method. A 
default method contains Teledyne LAB’s recommended basic and 
advanced settings for the use of a default column (as selected in 
the CONFIGURATION window). A default method for each size and 
type of column can be defined in the CONFIGURATION window. 
Default methods provide a starting point for your separation or 
purification. From these initial settings, you can perform a puri-
fication run, or you can modify the settings for your next run. 
Subsequent runs will use the settings in the active (temporary) 
window. If you have modified the settings, you can save the 
method file for future use.

If you find that the default methods are not a practical starting 
point for your applications, the methods can be changed to meet 
your specific requirements.

4.1.3 Run Files When the system has finished a run, it saves the run data in a 
Run file. This includes the method parameters used during the 
separation (but not a reference to the method name, as that 
method could have subsequently been edited to different param-
eters), rack and tube information, a pressure trace of system 
pressure, spectral data, optionally mass spectrometer data and a 
chromatogram containing information from each of the detectors. 
You can open and review the RUN FILES stored by the system. To 
open a RUN FILE, select FILE > OPEN. Run files use an *.run file
name extension.

4.2 PeakTrak Menu 
Options

PeakTrak menu options include

• FILE (Section 4.2.1)

• METHOD EDITOR (Section 4.2.2)

• MS (Section 4.2.3)

• TOOLS (Section 4.2.4)

• HELP (Section 4.2.5)
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4.2.1 File

Figure 4-2 The File Menu 

The FILE menu offers commands for managing and saving files:

New – Opens a new method file. PeakTrak opens the MAIN 
window using the default program settings for the default 
configured column size.

Open – Opens a METHOD FILE (.pmtd) or a RUN FILE (.run) 
stored on the system’s internal hard drive.
Manage Files – Opens a window from which you can archive or 
delete method and run files from the current directory. You can 
archive files by connecting a USB Flash drive and selecting COPY 
or MOVE FILES TO FLASH DRIVE.

• To remove a file from the internal hard drive, highlight 
the file or enter the filename, then select DELETE.

• To remove multiple files, you can drag to highlight 
multiple files, or select DELETE BY AGE. Then specify the 
age limit in months and select OK.

Note
Use the MOVE and DELETE options with caution, as the files 
cannot be recovered from the internal hard drive once the 
action is complete.

Set Data Path – Opens the SET DATA PATH window to specify 
your default METHOD FILE and RUN FILE storage folder location. 
Different users can have their own data paths.
Save Method – Saves the settings of the current method file to 
the system’s internal storage. If the method is not named, 
SAVE METHOD prompts you to name the file.

Note
Default methods are an exception and cannot be overwritten 
by SAVE METHOD. If a Default method is open and you attempt 
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to save any modifications to that method, the FILES window 
appears, so you can rename the method file. This preserves 
the default method. The Default method must be edited in the 
Prep HPLC tab. 

Save Method As – Renames the current method with a 
name that you choose and saves it on the system’s internal 
hard drive. 

Save Run As PDF – Saves the displayed run. The default 
file name for the run is the same as for the Run file, except 
it has a .pdf file name extension. (PDF files can be opened 
and printed on the external computer with Adobe Reader, 
for example.) If you select SAVE RUN AS PDF from the 
touchscreen, a file download window opens on which you 
can select a location and enter a file name. If you select 
SAVE RUN AS PDF from a remote computer, the file is saved 
to the remote computer’s hard drive.

Save Run As TXT – Saves the displayed run. The default 
file name for the run is the same as for the Run file, except 
it has a .txt file name extension. “TXT” files are actually 
XML code. These files can be opened with text editing 
software. They can also be imported into a spreadsheet for 
data manipulation. If you select SAVE RUN AS TXT from the 
touchscreen, a file download window opens on which you 
can select a location and enter a file name. If you select 
SAVE RUN AS TXT from a remote computer, the file is saved 
to the remote computer’s hard drive.

Import Method – Loads a method file (.pmtd) from an 
external source onto the system’s internal storage. If 
IMPORT METHOD is selected from the touchscreen, 
PeakTrak opens a FILES window to select the file on a USB 
flash storage device. If IMPORT METHOD is selected from a 
remote computer, you can select the method file from your 
local computer or network. After selecting the file, select 
OPEN to save the METHOD FILE on the system’s internal 
hard drive.

Export Method – Saves a method file (.pmtd) in a location 
other than the system’s internal hard drive. Use this to 
archive method files or to transfer the method to another 
system using IMPORT METHOD. From the touchscreen, 
EXPORT METHOD opens the FILES window so that you can 
save the file on a USB flash storage device. If EXPORT 
METHOD is selected from a remote computer, the file is 
exported and downloaded to that computer.

Save Queue As – Saves the queue on the system’s internal 
hard drive for later use. The file name is given the .queue 
extension.

Print – Prints the completed run on the network printer if 
selected the touchscreen. If selected from a remotely 
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connected computer, PeakTrak displays the printer 
window. From this window, you can select and configure the 
printer of your choice. After configuring the settings, PRINT 
the completed run.

Logout – Logs you out of the system. Afterward, the system dis-
plays a login screen and waits for the next user to log in.

4.2.2 Method Editor Selecting METHOD EDITOR from the menu opens the METHOD 
EDITOR window. Use METHOD EDITOR to view and modify basic 
and advanced method file settings.
METHOD EDITOR is described in detail in Section 4.3.4.

4.2.3 MS The MS menu  is  on ly avai lable  when  a  PurIon Ma ss 
Spectrometer is added to the ACCQPrep system. Furthermore, 
STANDBY and OPERATE are not available from a remotely con-
nected computer via a web browser.

Figure 4-3 The MS menu

The following options are available:

Method Development – Opens the MS METHOD 
DEVELOPMENT window to verify ionization conditions for 
the compounds to be purified. The ION FINDER window may 
also be opened from the MS METHOD DEVELOPMENT 
window (Section 4.3.6).

Manual Control – Opens MS MANUAL CONTROL to prime 
and control the carrier solvent pump and switching valve on 
the mass spectrometer fluid interface. MANUAL CONTRO is 
not available from a remotely connected computer via a web 
browser.

Ionization settings – Opens IONIZATION SETTINGS to create 
custom ionization parameters that can be saved for various 
compound classes and projects. This command is not 
available from a remotely connected computer via a web 
browser.

Operate – Sets the status of the PurIon mass spectrometer 
from standby to an operational mode by applying power to 
the heaters and dynode detector. Ntrogen gas is also 
supplied to the nebulizer. When the mass spectrometer is 



ACCQPrep HP150 
Section 4   PeakTrak

4-7EAR99 Technology Subject to Restrictions Contained on the Cover Page

already in operate mode, this menu item is unavailable; 
STANDBY replaces it.

Standby – Turns off all high voltages within the PurIon, 
including the dynode detector, to prolong its life. In 
addition, it sets the inlet capillary heater temperature to 
50 °C, turns the remaining heaters off, and lowers the gas 
flow rate to about 0.2 liters/minute. When in standby mode, 
OPERATE is used to return the PurIon to the operational 
state (high voltages on, heaters on, and gas flow at the 
proper rate of about 4 liters/min). When the mass 
spectrometer is already in standby mode, this menu item is 
unavailable; OPERATE replaces it.

Shutdown – Removes power to the heaters and removes 
power from the turbomolecular pump. A window appears to 
confirm that you want to initiate the shutdown procedure. 
SHUTDOWN is used to shut down the PurIon mass 
spectrometer for maintenance or to move the system.

WARNING
When a PurIon is installed, do not shut down or disconnect the 
vacuum line to the roughing pump until the PurIon is fully vented 
as indicated by PeakTrak.

4.2.4 Tools

Figure 4-4 The Tools menu
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The TOOLS menu provides options to configure and manually 
control your ACCQPrep system.

Manual Control – Opens MANUAL CONTROL, from which 
you can operate the system manually. It can assist with 
priming or purging the internal plumbing and aid system 
troubleshooting. Options on this window are covered in 
detail in Section 4.3.9  Manual Control.

Automation Manual Control – Provides tools to prime the 
wash station and to manually wash the probe or injection 
loop.

Large Sample Manual Control – Runs the large sample 
pump. See Section 4.3.11  Large Sample Manual Control.

Auto Zero – Zeros the detector trace(s) during a run.
Configuration – Opens the CONFIGURATION window, from 

which you can specify the solvents used with the system, set 
default volumes for collection tubes, set the system date and 
time, configure network settings, etc. Options on the 
CONFIGURATION window are covered in detail in Section 2.1  
Configuration of the ACCQPrep.

Set Administrator Password – Opens the SET 
ADMINISTRATOR PASSWORD window. You must enter a 
password to access this window. The default password set 
on the system is “accqprep”. If you change the password, 
make a record of the new password in a safe place. 
Passwords prevent unauthorized modifications to:

• User management

• System date and time

• System password
See Section 4.3.13 for step-by-step instructions.

User Management – Opens the USER MANAGEMENT window, 
from which you can add or remove users from the system and 
change passwords. To prevent unauthorized changes to user 
management, this function is password protected. See Section 
4.3.14 for step-by-step instructions.

4.2.5 Help

Figure 4-5 Help menu
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The HELP menu provides information about the system:

Service – Provides access the system’s service functions to 
qualified service personnel. These service functions are 
password protected to restrict their use to trained 
personnel. Access to SERVICE requires the administrator 
password.

Software Update – Opens a window used to install patch 
files to update your ACCQPrep system software.

Export Log Files – During operation, the system writes 
operating data to a log file. If you are accessing the system 
over a network, the files are saved to your PC; otherwise, 
they are be saved to a connected USB drive. Teledyne ISCO 
service personnel can interpret this data to optimize system 
performance or to troubleshoot difficulties. Teledyne ISCO 
recommends that you use EXPORT LOG FILES only when 
advised by a qualified service technician.

Backup / Restore – Opens a window to back up a 
configuration, columns and methods, users, or user data to 
a ZIP file or restore it from a file. Access to these functions 
requires the administrator password.

About PeakTrak – Reports version information for 
PeakTrak and for firmware, and displays networking 
addresses.

About ISCO – Displays contact information for Teledyne ISCO. 
You may also contact Teledyne LABS at www.teledynelabs.com.

4.2.6 Backup / Restore 
Procedures

To back up instrument settings and data:

1. Plug in a USB drive.

2. Select HELP > BACKUP / RESTORE. The Backup / Restore 
window opens.

3. Select BACKUP. A backup file is saved to the USB drive.

To restore instrument settings and data from a backup:

1. Plug in a USB drive containing the backup file.

2. Select HELP > BACKUP / RESTORE. The BACKUP / RESTORE 
window opens.

3. Select items from the backup file that you want to restore.

4. Select RESTORE.

4.3 PeakTrak Windows This section contains descriptions of the windows used for most 
PeakTrak tasks:

• MAIN window (Section 4.3.1)

• FILE menu windows (Section 4.3.2)

· SET DATA PATH (Section 4.3.3)

• The METHOD EDITOR (Section 4.3.4)
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• MS menu windows

· MS Method Development (Section 4.3.5)

· Icon Finder (Section 4.3.6)

· MS Manual Control (Section 4.3.7)

· MS Manual Ionization Settings (Section 4.3.8)

• TOOLS menu windows

· Manual Control (Section 4.3.9)

· Automation Manual Control (Section 4.3.10)

· Large Sample Manual Control (Section 4.3.11)

· Configuration (Section 4.3.12)

· Set Administrator Password (Section 4.3.13)

· User Management (Section 4.3.14)

4.3.1 The Main Screen The MAIN screen gives you control of the frequently used func-
tions before and during the run. After a run, or when viewing 
previous runs, MAIN displays peak collection data and the set-
tings used for that run. MAIN dynamically changes to display the 
controls required for the current state of the system.

When RUN SCREEN is selected, the top region of the MAIN screen
always displays a GRADIENT PLOT area (1). The bottom region of 
the window displays the RUN SETTINGS (2), RUN CONTROL 
buttons (3), and PEAK COLLECTION buttons (4). After a run, the 
left side of the window changes to show the collection rack map 
or the method parameters in a PEAK COLLECTION DATA pane (5).

Figure 4-6 The Main screen, annotated
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Figure 4-7 The Run Screen at the end of a run

Gradient Plot – The gradient plot area depicts the current 
gradient that will be used for the run. Depending on the 
setting to the CV TO TIME/CV TO TIME/TIME TO CV toggle 
(see Button bar), the X-axis of the plot displays the run time 
in minutes or in column volumes. The X-axis scale can be 
adjusted by typing or selecting the RUN LENGTH. The left 
Y-axis displays detector(s) units of measure, and the right 
Y-axis indicates the percentage of solvent B. By default, 
PeakTrak automatically scales the left Y-axis to best 
display the detector trace. PeakTrak also sets the right 
Y-axis to 100%. You can override the Y-axes scales by 
selecting the FORMAT GRAPH button and setting the values 
you want.  
 
To zoom into a portion of the graphic area, “pinch zoom” and 
“swipe.” To pinch zoom, place two fingers on the 
touchscreen in the graphics area, then move them apart to 
zoom in. Moving both fingers together (swiping) pans the 
display area. (A single finger touch is interpreted as a 
selection rather than a pan.) 
 
The gradient plot area also provides a convenient method to 
edit the gradient curve. You can select and drag any of the 
points to change the shape of the curve and use the buttons 
at the bottom of the plot area to insert and delete points. 
For complete instructions on defining gradient curves, see 
Section 4.4.3  Defining a Gradient.

MS – Displays the current mass spectrum on PurIon systems. 
This spectrum hides the flow rate and solvent selection controls. 
Selecting the MS control again causes the spectrum to disappear. 



ACCQPrep HP150 
Section 4   PeakTrak

4-12 EAR99 Technology Subject to Restrictions Contained on the Cover Page

When the spectrum is displayed, touching the chromatogram at 
any point prior to the current elution time displays a spectrum at 
that point in time. The elution time corresponding to the 
spectrum is displayed under the spectrum. 

· LIVE DATA shows the current spectrum. 

· ADD SPECTRUM is only displayed after completion of 
the separation and saves the spectrum at a point for 
inclusion in the run report screen. Up to 4 spectra 
can be saved in a run report. The button with a 
triangle pointing down cycles through saved spectra. 

· The ± button displays the positive or negative ion 
spectrum (PurIon S and PurIon L systems only). A 
dot in the button indicates whether the positive or 
negative ionization spectrum is displayed.

UV  – UV (UV-Vis on ACCQPrep systems with a UV-Vis detector) 
toggles the display of the UV spectrum. This spectrum hides the 
flow rate and solvent selection controls. Selecting UV again 
causes the spectrum to disappear. When the spectrum is dis-
played, touching the chromatogram at any point prior to the 
current elution time displays a spectrum at that point in time.
The elution time corresponding to the spectrum is displayed 
under the spectrum. LIVE DATA shows the current spectrum. ADD 
SPECTRUM saves the spectrum at a point for inclusion in a run 
report screen. Up to four spectra can be saved in a run report. 
The button with a triangle pointing down cycles through saved 
spectra. 

Run Settings – 
• COLUMN — The column used on the system. If the 

system has a Column Selector Valve Module, other 
installed columns to use for separation can be selected 
from the list. A second level menu provides methods 
already associated with the selected column.

• SAMPLE NAME —A label for the run. Type a unique 
descriptor. PeakTrak saves the run information under 
this name. Therefore, PeakTrak cannot accept any 
characters that are reserved by the operating system (* 
? / \, etc.). Spaces are not allowed in the name. If you do 
not type a Sample Name, PeakTrak generates a 
date/time stamp for the name when you select START to 
begin the run.

• FLOW RATE — A flow rate for the run. Type it or select a 
rate from the list.

• DETECTOR — Controls the current peak detection mode. 
To change the peak detection settings, open the METHOD 
EDITOR window.

• SOLVENTS A AND B— If the system doesn’t have the 
Solvent Selector Valve Module, you can select a solvent 
name from the list. The solvents in the list are those 
defined by the CONFIGURATION window. If the Solvent 
Selector Valve Module is installed, this control selects a 
solvent for use in the current separation. 
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Run Control Buttons – From left to right, the control 
buttons:

• START (the “play” symbol) — Starts or resumes the run. 
This is only present before the run has started; 
afterward, this is replaced by ISOCRATIC HOLD.

• ISOCRATIC HOLD (the “pause” symbol) — Holds the %B 
at the current value while the system continues to 
operate (sometimes called an isocratic hold). This is only 
present after the run has started; otherwise, START 
replaces it.

Note
Pausing the run extends the run length. While in the paused 
state, you can resume the gradient by selecting START, or stop 
the run by selecting STOP FLOW. If you resume the run, the 
system continues the gradient curve from the %B when the 
system was paused.

• STOP FLOW— Suspends the entire run. Unlike in the 
paused state, the pump, peak detection, and fraction 
collection will not operate. While stopped, you can abort 
the run by selecting RESET or TERMINATE, or resume the 
run by selecting START. In either case, the data is always 
saved. Using TERMINATE is the recommended way to 
abort a run because this runs sample probe wash and 
cone cleaning routines (PurIon systems only) to clean 
the system for another run. 

• TUBE ADVANCE — Advances the fraction collector to the 
next tube position. This allows you to conveniently 
collect the eluent of interest in a new tube.

• RESET (the “rewind” symbol) — Available when the 
system has completed the run or when the run was 
stopped by selecting STOP. RESET returns you to the 
MAIN screen.
If you want to terminate the separation prematurely, 
selecting TERMINATE is recommended. Unlike REWIND, 
TERMINATE does not modify the current method’s run 
length setting.

• TERMINATE (the “fast forward” symbol) — Jumps to the 
next step of a run. After you’ve started a run, the system 
performs several steps. The first step is to deliver 
solvents using the programmed gradient for the entire 
run length. When this step is complete, the system 
enters the sample probe cleaning step. 
Selecting TERMINATE causes the system to skip any 
remaining time in the current step and advance to the 
beginning of the next step.  
If you have stopped the run before its programmed run 
length has elapsed, the current method is modified 
using the new run length. This modified method is ready 
for the next run, or can be saved for future runs
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Peak Collection Buttons – Three peak collection buttons 
are located at the bottom of the MAIN window.

• ALL — Collects all eluent in the fraction collection tubes. 
Detected peaks advance to the next tube automatically 
to maximum peak concentration and purity

• PEAKS — Collects only eluted peaks in the fraction 
collection tubes.

• NONE — Diverts all eluent to the waste port. This is 
sometimes used to divert all peaks except the peak of 
interest to waste. Diversion can also be accomplished 
with the INITIAL WASTE & TIME WINDOWS functions.

• NO INJECTION/NO COLLECT— Runs a method without 
injection and without collecting peaks. Useful for setting 
up column conditioning or washing methods for using in 
the queue.

Peak Collection Data – Peak Collection data is displayed 
in the MAIN window after a run. You may also open a run 
file for viewing data from previous runs. Selecting on a test 
tube with the mass spectrum window displayed displays the 
mass spectrum for compounds collected into that tube 
(PurIon systems only). Selecting on adjacent tubes allows 
you to determine which fractions may potentially contain 
impurities.  
The peak collection data is displayed on the left side of the 
MAIN window:

• Rack and tube information — Collected peaks are color 
coded in the rack diagram so that you can easily locate 
the peaks of interest. The tube colors correspond to the 
color bars under the peaks displayed on the 
chromatogram. If more than one set of tube racks was 
filled during the run, select NEXT and PREVIOUS RACK to 
view the additional racks. The table below the rack 
diagram displays the peak data in tabular form.

• DISPLAY METHOD — Toggles a summary display of the 
method settings for the run. You can return to the rack 
and tube display by selecting DISPLAY RACK again.

4.3.2 Files The Files window is modal. That is, its function and features 
change according to the command used to open the window. Com-
mands such as FILE > OPEN and SAVE METHOD AS or the OPEN
and SAVE AS buttons open this window. Use this window to 
browse the system’s files and folders using the following controls:

• Current Path — The top-left corner of the window 
displays the path (current folder). As you browse 
through the files, the path updates as you go. You can 
select the folder names to return to upper folder levels.

• File and Folder operation buttons:
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· COPY — Copies a highlighted file to the system’s 
clipboard.

· PASTE — Pastes a file from the clipboard. If the file 
already exists in the current folder, the system 
ignores PASTE to prevent the original file from being 
overwritten.

· DELETE — Deletes the highlighted file or a folder and 
its contents.

· NEW FOLDER — Creates and names a new folder.

· UP — Navigates to the next-higher folder level for 
browsing.

· SEARCH — Finds file names matching a KEYWORD or 
words. Select CLEAR SEARCH to clear the results.

· FILE MANAGEMENT options — Select COPY FILES TO 
FLASH DRIVE or MOVE FILES TO FLASH DRIVE to 
create archive copies (PDF or Text) of the files on a 
connected flash drive. Select DELETE BY AGE to 
specify an age limit beyond which to delete files from 
the internal hard drive.

· FILE/FOLDER info scroll box — Lists the contents of 
the current folder. The contents can be sorted by 
selecting the column headings.

· FILE TYPE — Limits the file list to certain types of 
files. Select a file type from the list.

· FILE NAME — Identifies the currently selected 
(highlighted) file or folder when browsing and 
opening files. When using SAVE AS, enter this to 
name the file.

· OPEN/SAVE/DELETE — Performs the listed action 
(e.g., OPEN a file).

· LOAD PREVIOUS RUN FROM DETECTED RACK — 
(Appears when selecting FILE > OPEN.) Instructs the 
system to read the RFID tag on a single rack and 
displays the last RUN FILE collected on the detected 
rack on this instrument. This feature is useful you 
are unsure of the rack’s contents.

Note
The rack must be placed in the left position in the instrument. If 
the AutoSampler is present, the rack must still be placed inside 
the ACCQPrep.

· CANCEL — Closes the window without saving or 
opening the file.

4.3.3 Set Data Path Use the SET DATA window to select a default folder for the 
current user. After selecting a folder, file operations such as 
saving or opening files will use this selected directory.
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File > Set Data Path SET DATA PATH is primarily used with the USER MANAGEMENT 
feature. USER MANAGEMENT automatically creates a folder for 
each user. When using the system, set the data path to your 
folder or a subfolder within. Each user has a different data path. 
The window contains the following controls:

• Current Data Path — Displays the path (current folder) 
at the top-left corner of the window. As you browse 
through the files, the path updates as you go.

• NEW — Adds and names a subfolder within the 
currently selected folder.

• DELETE — Deletes the selected folder.

• Folder selection box — Lists available folders and 
buttons that select them.

• OK — Saves the selected folder as the data path and 
closes the window.

• CANCEL — Closes the window without changing the 
data path.

4.3.4 Method Editor Each section of the METHOD EDITOR groups its options by 
function. The BUTTON BAR (1) at the top of the window gives you 
quick access to file operations, and column data. Below the 
BUTTON BAR are the RUN SETTINGS (2) and the RUN NOTES (3). 
The lower part of the window contains the GRADIENT PLOT AREA 
(4) and options for PEAK COLLECTION (5), PEAK DETECTION (6), 
and to EDIT [the] GRADIENT (7).

Figure 4-8 Method Editor screen with Peak Collector and 
Peak Detector panels

Selecting the Edit Gradient button at the bottom of the METHOD 
EDITOR toggles either the PEAK COLLECTOR and PEAK DETECTOR
panels (shown above) or the EDIT GRADIENT panel (shown below). 
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Figure 4-9 Method Editor screen with Edit Gradient panel

Button bar – Provides commands for opening, editing, and 
saving methods.s. Saved methods can be retrieved for 
further editing or use. 

Figure 4-10Method Editor Button Bar
The METHOD EDITOR Button Bar contains the following 

options from left to right:
• NEW (a blank document icon) — Opens a new method 

file using the default method settings for the selected 
column.

• OPEN (an open folder icon) — Opens a method file stored 
on the system’s internal hard drive.

• SAVE (a diskette icon) — Saves any modifications to the 
current method file. If you attempt to save modifications 
to a default method file, the FILES window opens instead 
and allows you to rename the file to preserve the default 
method. 

• SAVE AS — Opens the FILES window. From this window 
you can rename the current method and save it on the 
system’s internal storage.

• EXIT — Closes the METHOD EDITOR and returns to the 
MAIN WINDOW.

• COLUMN DATA — Opens the Column Data window, 
which reports information about the RediSep ACCQPrep 
column installed in the system. This information 
includes. The “Number of times used,” “First used on,” 
and “Last used on” information can help you determine 
when the column should be replaced. The “Last fluid 
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used” helps you determine if any solvent remaining in 
the column will be miscible with the solvent currently 
used in the system. To view the Column Data window, 
open the METHOD EDITOR window, then select COLUMN 
DATA.

• CV TO TIME/TIME TO CV— Toggles the units used to 
enter and/or report EQUILIBR. VOL., RUN LENGTH, and 
the Gradient Plot X-axis units. Setting units to CV may 
make method scale-up or other calculations easier.

Run Settings – Sets options for the run.

Figure 4-11Method Editor Run Settings

• COLUMN —Displays the name of the currently selected 
column. If a Column Selector Valve Module is installed, 
this selects the column used for the current separation. 

• SAMPLE NAME — The sample name is a text entry box in 
which you can label the run. Type a unique descriptor. 
PeakTrak saves the run information under this name. 
Therefore, PeakTrak cannot accept any characters that 
are reserved by the operating system (* ? / \, etc.). A 
space can’t be used in the sample name. If you do not 
type a SAMPLE NAME, PeakTrak generates a date/time 
stamp for the name when you select START to begin the 
run.

• FLOW RATE — Type or select a flow rate for the run. 
When using the default column methods, the system 
sets the flow rate to the configured flow rate of the 
column.

• EQUILIBRATION VOLUME — Type or select the volume of 
solvent that is pumped through the column and out the 
waste port before the sample is introduced. The volume 
can be entered in minutes or in column volumes, 
depending on the setting to the CV TO TIME/CV TO 
TIME/TIME TO CV toggle. (See Button bar.) Data is not 
collected while this volume is being pumped. 

• INITIAL WASTE & TIME WINDOWS — Opens a window 
from which you can view and modify these settings.

Setting
Time 
toggle

CV (colume volume) 
toggle

Equilibration Vol. mL CV

Run Length minutes CV [Min.]

X-axis minutes CV
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For the INITIAL WASTE, type or select the volume of eluent 
that is allowed to pass through the column to the waste 
port after the sample is injected. Use this feature to  con-
serve collection tubes by diverting all fluids during this 
time period, even if a peak is detected.

TIME WINDOWS can limit the fraction collection to specific 
time durations of the run. To use time windows, 

1. Enter a START time and an END time. All times are 
relative to start of the run, just following the sample 
injection.
2. Then choose a PEAK COLLECTION mode. If you select 
ALL, the module collects all fluid during the time win-
dow regardless of the peak state. PEAKS collects fluid 
only when the time window is active and a peak is pres-
ent.
3. Enter more time windows as needed.
Detected peaks will still trigger tube advances. 

• LOOP BYPASS— Automatically switches loop out of fluid 
path after selected times of sample volume has passed 
through. Useful for analytical scale, as it simulates a 
loop size equivalent to the value you choose without 
physically changing to a smaller loop, minimizing delay 
time for the gradient to reach the head of the column.

Run Notes – Use this text entry box to enter comments or 
notes for the run. These comments are be saved with the 
run and appear in TXT and PDF reports. Column 
identification information is automatically placed in this 
box.

Figure 4-12Method Editor Run Notes
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Gradient Plot Area – Depicts the current gradient profile that 
will be used for the run. The X-axis of the plot displays the run 
time in minutes or in column volumes, depending on the setting 
to the CV TO TIME/CV TO TIME/TIME TO CV toggle. (See Button 
bar). The X-axis scale can be adjusted by typing or selecting the 
RUN LENGTH in minutes (or column volumes). The left Y-axis dis-
plays absorbance units, and the right Y-axis indicates the per-
centage of solvent B.

Figure 4-13Method Editor gradient plot area

The gradient plot area also provides a convenient method to edit 
the gradient curve. You can select and drag any of the points to 
change the shape of the curve, or use the buttons at the bottom of 
the plot area to insert and delete points. To zoom into a portion of 
the graphic area, use “pinch zoom” and “swipe.” Pinch zoom is 
accomplished by placing two fingers on the graphics area and 
moving them apart to zoom. Once zoomed in, moving both fingers 
pans the display area. (A single finger touch is interpreted as a 
selection rather than a pan.)
The following controls appear in the Gradient Plot Area:

• INSERT — Activates the gradient point insert mode. 
When active, select the gradient curve to add a single 
point. You can then drag the new point to any desired 
position. Select INSERT once for each gradient point that 
must be added to the plot area.

• DELETE — Activates the gradient point delete mode. 
When active, the point nearest to the next point selected 
on the gradient curve is deleted. Select DELETE once for 
each point that must be deleted from the plot area.

• RUN LENGTH — Type or select the length of the run. The 
length is expressed in minutes or in column volumes, 
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depending on the setting to the CV TO TIME/CV TO 
TIME/TIME TO CV toggle. (See Button bar.)

Note
Run Length changes the scale of the X-axis on the gradient. 
Points that define the gradient will be automatically scaled to fit 
the new run length. 

• Solvents A and B— Select a solvent from the list. The 
available solvents are those defined by the CONFIGU-
RATION settings. You can program mid-run solvent B 
changes by selecting EDIT GRADIENT to open the 
GRADIENT TABLE.

• EDIT GRADIENT — Opens the gradient table. Although 
the gradient may be edited directly within the plot area, 
you can also edit the gradient in tabular form. The 
gradient table also lets you program solvent changes in 
the gradient. See the Edit Gradient section below.

• For complete instructions on defining gradient curves, 
see Section 4.4.3  Defining a Gradient. The gradient 
table depicts the points that define the gradient curve in 
a tabular format. From this table you can change 
Solvent, the duration, and %B concentration of any 
point on the curve. To do so, select the new value for a 
gradient point. Changes that you make to the table are 
reflected in the gradient plot area. You can also change 
the number of points on the curve by inserting or 
deleting rows in the table. To change the number of 
points, first highlight a table cell or row. Then select the 
appropriate GRADIENT button for the action you desire.

• INSERT POINT — Inserts a row below the selected point 
on the gradient table.

• DELETE POINT — Deletes the selected row on the 
gradient table. You cannot delete the initial point. There 
must be at least two points to define a gradient. The 
system automatically updates the RUN LENGTH setting 
or scales the other points when you change the number 
of points and their duration on the curve. To close the 
gradient table, select the EDIT GRADIENT toggle. See 
Section 4.4.3  Defining a Gradient.

• 3RD SOLVENT MODIFIER (IF EQUIPPED) — Allows you to 
configure a third solvent modifier. Requires the 
additional 3rd solvent modifier pump module.
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Peak Collection – Sets the collection mode.

Figure 4-14Method Editor Peak Collection

• ALL — Collects all fluids in the fraction collection tubes 
during a run.

• PEAKS — Collects only eluted peaks in the fraction 
collection tubes during a run.

• NONE — Diverts all fluids during a run to the waste 
port.

• Tube Volume — Specifies the tube volume for collected 
fluids. This volume can be the default maximum volume 
for that tube size (Max option) as entered in the CONFIG-
URATION window, or a method-specific volume that is 
less than the capacity defined by the CONFIGURATION 
window. 

Note
The actual fraction size may be less if a newly detected peak 
causes a tube change or if you select TUBE ADVANCE.

• Peak — Type or select a volume to be collected in each 
tube when the system detects a peak.

• Non-peak — Type or select a volume to be collected in 
each tube when peaks are not detected. This setting 
allows you to conserve tubes without diverting non-peak 
elute to waste. This setting is ignored when the peak 
collection mode is set to Peaks or None.

• NO INJECT/ NO COLLECT —Runs a method without 
injection and without collecting peaks. Useful for setting 
up column conditioning or washing methods for using in 
the queue.

Peak Detection – This section of the METHOD EDITOR 
provides peak detection options. 
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Note
You can select up to four peak detection options on the 
ACCQPrep HP150 system. If more than one option is 
selected, such as 1 with 2, the system considers a peak to 
be present when an option is true (a logical OR).

Figure 4-15Method Editor Peak Detection

When a detection method is enabled, selecting DETAILS opens a 
DETECTION OPTIONS window that modifies that method’s set-
tings.

Figure 4-16A Detection Options window

All enabled options are displayed on the chromatogram. Options 
and settings for ACCQPrep systems are described below.
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Wavelength Peak Detection • 1 and 2 (wavelength 1 and 2) — Select these to use and 
configure primary and secondary wavelength detection. 
2 is set to monitor (displayed but not used for peak 
detection and cutting) by default.
When selected, type or select the peak detection wave-
length in nanometers, then select DETAILS to configure 
additional settings described below.

Wavelength Peak Detection 
Details

· Signal Gain – Modifies the gain to scale the detector 
signal.

· Slope Based — Enables slope-based peak detection. 
Peaks are recorded when the slope algorithm detects 
a peak similar to the Peak Width setting.

· Peak Width — Select the average peak width setting.
Peak widths are measured at the baseline. The slope 
detector typically detects peak widths ranging from 
about 0.2 to 2 times the peak width setting. For exam-
ple, if you entered a peak width of 1 minute, the range 
would be 12 seconds to 2 minutes. For best operation, 
the peak width should be set to just over the average 
peak width being separated. For instance, if the aver-
age peak width is 45 seconds, enter a peak width of 
1 minute. For most flash chromatography, 1 minute is a 
good starting point for a peak width. Sometimes very 
small peaks need a larger peak width setting since 
their small height results in a smaller slope than larger 
peaks of the same width.
Detection ends when the detector signal drops to 
0.01 AU below the value entered here. This reduces the 
potential of multiple peaks being detected if a noisy sig-
nal oscillates around the threshold value.

· Threshold — Enables threshold peak detection. 
When enabled, peaks are recorded if the Absorbance 
Units (AU) value is exceeded. Type or select the 
Absorbance Units value to be used for Threshold 
detection.

Note
If both Slope and Threshold peak detection methods are 
checked, the system considers a peak to be present when any 
one condition is met. This logical OR operator means that the 
system will cut a peak when either the Slope condition is true, 
or when the Threshold condition is true.

· Monitor — Uses the detection source as a monitor. 
When enabled, the detection source is displayed as a 
trace on the gradient plot area but is not be used to 
cut peaks.

All Wavelength Peak 
Detection

• All Wavelength Detection — Detects peaks within a 
user-selected range of wavelengths. When checked, 
select DETAILS to configure additional settings. These 
settings include the slope-based and peak width options 
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described for 1 and 2 above. Here, PEAK WIDTH is used 
to determine solvent absorbance suppression. Peaks 
that are twice the peak width are deemed to be solvent 
or other baseline drift, and their absorbance spectrum 
are subtracted as an assumed baseline spectrum.

All Wavelength Details · MINIMUM and MAXIMUM  sets a limit in 
nanometers. This limit eliminates areas of little 
spectral information from the all wavelength 
detection signal, resulting in a stronger signal.

ELS Peak Detector • ELS Detector — Enables the evaporative light 
scattering (ELS) detector on an ACCQPrep system. 
When enabled, select DETAILS to configure additional 
settings:

ELS Detector Details · Sensitivity - Can be selected as NORMAL to keep 
largest peaks on scale or HIGH to detect small peaks.  
The default setting is HIGH to ensure most 
compounds are detected.

· Signal Gain – Modifies the gain to scale the detector 
signal.

· Slope Based and Threshold – Refer to these features 
described above for 1 and 2 .

· Spray Chamber Temperature – The default settings 
are 30 °C (normal phase default methods) and 20 °C 
(reverse phase). This setting may be adjusted from 
10 to 60 °C so that detection can be optimized for the 
solvent system in use. However, operation at 
temperatures greater than 5 °C below the ambient 
temperature is not guaranteed. Lower temperatures 
cause more of the solvent to condense before entering 
the drift tube. This is useful to limit the amount of 
solvent aerosol entering the drift tube allowing the 
drift tube temperature to be set lower. This setting is 
limited to a minimum of 5 °C below the ambient 
temperature.

· Drift Tube Temperature – The default settings are 
60 °C (normal phase default methods) and 60 °C 
(reverse phase). This setting may be adjusted from 
30 to 90 °C but is limited to a range of 5 °C below and 
60 °C above the ambient temperature.
The drift tube temperature must be high enough to 
evaporate the solvent aerosol entering the drift tube. If 
the temperature is not high enough, unevaporated sol-
vent may form a fog that condenses on the detection 
system preventing detection of the compounds. This 
can be corrected by selecting ELSD ON in the MANUAL 
CONTROL window to turn on the flow of gas through the 
drift tube without liquid. Temperatures that are too 
high can cause semivolatile compounds to vaporize and 
become undetectable.

Mass Spectrometer Peak 
Detection

• Mass Spectrometer – Monitors or detect compounds 
with a PurIon mass spectrometer system (PurIon 
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systems only). Mass-directed peak detection can be set 
for up to 6 masses or 5 masses and 1 range.

Figure 4-17MS Detection Options window

MS Detection Details · Threshold – Selects the START and END signal 
intensity ratios for directing fraction collection.
This limits fraction collection for peaks that have tail-
ing tendencies. Such peak tails may cause collection of 
many fractions that contain a very small amount of 
compound. Consequently, MS detection can lead to 
compound tailing that causes excessive fraction collec-
tion.
Usually, the default THRESHOLD settings control com-
pound tailing adequately. However, adjusting the 
START or END thresholds to define an asymmetric 
threshold may be required to improve peak cutting to 
minimize collection of such fractions and speed the col-
lection process:

· Start Threshold – The multiple of the mass 
spectrometer signal's noise baseline level at which 
peak collection starts. Setting it lower can allow the 
software to start collecting compound more quickly, 
and it may slightly improve recovery while 
minimizing the number of collected fractions. The 
noise level is measured at the first column volume.

· End Threshold – The percentage of the maximum 
peak height of the current peak at which detection 
stops and collection ends. For example, entering 20% 
ends collection at 20% of the peak height. Setting a 
percentage of peak height can allow proper collection 
of both large and small peaks. Setting this to 0% 
instructs peak collection to use the START noise 
threshold.
Selecting THRESHOLD deselects MONITOR.
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· Monitor – When selected, prevents fractionation 
based on the mass spectrometer signal. 
Selecting MONITOR deselects THRESHOLD.

· Terminate On Target – When selected, stops the run 
after all mass spectrometer detection ions have been 
detected.

· Detection Ions – Sets ions for detection or ions to be 
monitored. Up to four single ions may be chosen, or a 
range of ions and up to three single ions may be 
selected. On PurIon S and PurIon L systems, 
detected ions may be a mixture of positive and 
negative ions.

· Spectrum Start/End – (PurIon S and PurIon L 
systems only)

· Positive Ionization – Selects positive ion spectrum 
(PurIon S and PurIon L systems only). 
Selecting POSITIVE IONIZATION deselects NEGATIVE 
IONIZATION.

· Negative Ionization – Selects positive ion spectrum 
(PurIon S and PurIon L systems only). 
Selecting NEGATIVE IONIZATION deselects POSITIVE 
IONIZATION.

· Ion Settings – Sets ionization parameters to enhance 
detection of molecular ion peaks.

· PurIon Loading – Sets the mass load (High, Medium, 
or Low); that is, the quantity of the carrier flow rate 
that is sent to the mass spectrometer (MS).

· High: 20 µL/min

· Medium: 6 µL/min

· Low: 1.467 µL/min
Setting the mass load too low results in significant signal 
delays, while setting it too high results in poor signal and 
clog the MS with excess sample.

The PurIon MS doesn't have a defined carrier fluid split ratio; 
instead, it uses an active splitter valve assembly that portions off 
a specific, programmable volume of the system flow. Portion 
volume is set independently of the carrier fluid flow rate (always 
0.2 mL/min).

The effective split ratio is system flow rate ÷ split flow rate. 
Some examples:

· At a system flow rate of 20 mL/min, the split ratios 
are 1000:1, 3333:1, and 13633:1. (That is, 
20 mL ÷ 20, 6, and 1.467 µL/min, respectively.)

· At a system flow rate of 100 mL/min, the split 
ratios are 5000:1, 16666:1, and 68166:1 (That is, 
1000 mL ÷ 20, 6, and 1.467 µL/min, respectively.)

· MS Detection Start/End – Sets the start and end 
times at which the MRA valve is active during the 
method. This avoids salts and other contaminates at 
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the start of a run and prevents unwanted compound 
from being sent to the mass spectrometer during a 
column wash.

Note
If the MS is not active during the start of the run, the MRA 
valve will not be active during equilibration or any pre-run sam-
ple loading when using the sample loading pump.

Purity Measure Peak 
Detection

• Purity Measure — When the DETAILS button is 
available, select it to configure additional settings:

· Show Ratio – Displays a ratio of the selected 
wavelengths when two absorbance wavelengths are 
used. The ratio trace is often a useful indicator of 
purity.

Purity Measure Details · Show Spectral Purity – Measures purity by using a 
comparison of the entire UV-spectra measured at 
differing times as a purity measurement.

· Spectral Purity Detection – Bases fractionation on a 
spectral purity threshold that you enter.

External Detector • External Detector — Enable to use a 0 to 1 volt analog 
signal from an external detector. When enabled, select 
DETAILS to configure additional settings. These settings 
include the slope-based and peak width options 
described above for 1 and 2 . The system uses its 
internal algorithms to cut detect and cut peaks on the 
basis of the analog input signal. Refer to the External 
Detector instruction sheet for cable and plumbing 
requirements.

The external detector option is not available on ACCQPrep
systems with ELSD or PurIon detectors.

Edit Gradient – This table changes the FLOW RATE at the 
time points on the gradient plot area. Select the EDIT 
GRADIENT button to toggle the gradient table open or closed. 
After the table is opened, add or delete time points, or select 
a field to highlight it and make the row editable.
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Figure 4-18Gradient Table

INSERT POINT – Add a time point before the point whose row 
is highlighted on the table. The new point appears at the 
same location as the highlighted row’s point. You can move 
it along the X-axis by changing the MINUTES or CV entry.

DELETE POINT – Remove the highlighted row and its 
associated point from the table.

SOLVENT A or B – The solvents that have been entered on the 
CONFIGURATION window > INSTRUMENT CONFIGURATION 
tab.

ML/MIN – The flow rate in mL per minute. A change in flow 
rate at a point is shown in the gradient plot area as a 
vertical line through and a callout at the previous point.

Note
Any changes to the flow rate in the gradient table occur almost 
immediately at that point. There is not a gradual change to the 
new set flow rate over the time period, unlike the gradual 
change of %B composition in the gradient table.

MINUTES/CVS – The number of minutes or column volumes 
from the previous time point, as viewed along the X-axis of 
the gradient plot area. The label of this control, the units 
used here, and units on the X-axis depend on the EDIT 
GRADIENT control toggle. (See Method Editor: Button bar.)

%B – The percentage of solvent B. Adjusting a value on a row 
also moves its point along the Y-axis.

4.3.5 MS Method 
Development 

(The MS METHOD DEVELOPMENT window is available on PurIon 
equipped systems only).
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MS > Method Development MS METHOD DEVELOPMENT provides a means to test and verify 
ionization conditions for their compound. This is not available 
from a remote connection.

Figure 4-19Mass Spectrometer Method Development 
window 

 MS METHOD DEVELOPMENT contains the following controls:

• Polarity — On the PurIon system: changes the probe 
polarity between positive and negative ionization. On 
PurIon S and PurIon L systems: toggles the displayed 
mass spectrum between positive and negative 
ionization.

• Ion Settings — Allows selection of different ion 
settings to maximize the intensity of the molecular ion. 
The factory selections include “Robust” for compounds 
that do not easily ionize. “Typical” works well for most 
compounds. The “Fragile” setting is used for those 
compounds that are delicate or easily fragment. Ion 
settings that you define may also be loaded.

• Ion Finder — Opens the ION FINDER window. The Ion 
Finder identifies potential adducts, fragments, and 
multiply charged species of the compound of interest 
when the compound of interest does not show up in the 
spectrum graph. Such ions can then be used to detect 
the compound of interest. See Section 4.3.6  Ion Finder.

• Detection Ions—After a spectrum is collected, 
selecting a peak adds that ion to this list. Alternately, 
masses can be entered using a keypad control.

• Clear Ions — Clears the last value entered into the 
DETECTION IONS list.

• Mass spectrum graph — Displays the mass spectrum. 
There are two mass spectra displayed. The spectrum 
depicted in blue shows what the PurIon is currently 
detecting. The red spectrum depicts the largest peaks 
detected. The red spectrum is reset after injecting a 
sample. 
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To inject a sample, move the PurIon injection valve to the 
“Inject Sample (>20 µg/mL)” position first. Inject a sample 
(>20 mL), then move the valve to the “Scan Mass” position.

Note
Only use 22 gauge square tip needles (PN 29-9001-911) to 
avoid scratching the internal surfaces of the injection valve! Fil-
ter the sample with a 0.45 µ filter to avoid clogging the PurIon 
tubing and probe capillary. Sample concentration should be 
less than 20 µg/mL.

• Modify View—Sets the displayed range of the mass 
spectrum. The PurIon system still collects the entire 
mass range even when the range is set within than the 
minimum and maximum values allowed for the 
spectrometer. Values can range from 10 to 1200 Da 
(PurIon or PurIon S) or 2000 Da (PurIon L). Changing 
the mass range defined by these controls may cause the 
Y-axis (ion count) scaling to change on the basis of the 
tallest peak within the range. The display only labels 
the m/z for the 10 most prevalent ions currently 
displayed. Formatting the graph to a narrower range 
causes the system to relabel the ions to identify ions 
that may not have been intense enough to be labeled on 
the broader range graph.

• Spectrum Name— A file name for the mass spectrum 
is needed only if you want to save the mass spectrum to 
a file for later viewing.

• Save Data— Saves the mass spectral data to the 
internal hard drive.

• Save as PDF— Saves the displayed spectrum on either 
a USB drive or a remote computer’s hard drive. The file 
name is the same as the spectrum name except it has a 
PDF extension. PeakTrak displays a file download 
window so that you can select a location and change the 
file name.

• Fluid Interface Pressure — The carrier solvent 
pressure, displayed in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow proper operation.

4.3.6 Ion Finder (The ION FINDER window is available on PurIon equipped 
systems only).

MS > MS Method 
Development > Ion Finder

The Ion Finder identifies potential adducts and fragments of the 
compound of interest when the compound of interest does not 
show up in the spectrum graph. It is useful when working with 
large molecules.

After entering a molecular weight, the Ion Finder algorithm 
looks for masses in the spectrum that match loss of various frag-
ments, adducts, and multiply charged ion species. It can detect 



ACCQPrep HP150 
Section 4   PeakTrak

4-32 EAR99 Technology Subject to Restrictions Contained on the Cover Page

and report multimers, solvent adducts, and charge carriers that 
replace protons such as sodium and potassium. It can detect pos-
itive, negative, and multiply charged ions.

After ions are detected, you can select any such ions that corre-
spond to the mass of interest and use them for detection.

Note
The Ion Finder has no knowledge of the compound, so some 
items in the Detection Ion list may not be associated with or 
even possible for the compound to be purified. Or, they may 
only be part of the injection or carrier solvent.

The Ion Finder only acts on the ten most intense peaks in the 
display. When impurities are present, some of the desired com-
pounds’ mass peaks may not be noted by the finder. In that case, 
rescaling the mass can eliminate unwanted intense peaks (pos-
sibly due to impurities) and allow detection of the desired com-
pound.

To use the Ion Finder:

1. Use the METHOD DEVELOPMENT window (MS > Method 
Development) to inject a sample.

2. Select POLARITY and ION SETTINGS. Changing the ION SET-
TINGS changes the ions seen. Remember that Ion Settings 
choices do not transfer to the detection options for the mass 
spectrometer in the METHOD EDITOR—the ion settings that 
gave a good result in the MS METHOD DEVELOPMENT win-
dow should be chosen.

3. Select ION FINDER. The ION FINDER window opens to dis-
play a list potential adducts and fragments detected in the 
compound of interest. Because of isotopes, multiple peaks 
near one another may be found. (For example, 546 and 547, 
also 818 and 819; Figure 4-20.)

4. Select the radio button next to a listed ion to add it to the 
ions to be detected.
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Figure 4-20The Ion Finder window 

• DESIRED MASS – The molecular weight of your 
compound, rounded to the nearest integer.

• DETECTION IONS – The list of possible adducts, 
fragments, or multiply charged ion species detected.

• DETECTION ION – The list of possible adducts or 
fragments detected based on the value entered in the 
DESIRED MASS and detected by the system. Checking an 
item adds it to the DETECTION IONS list.

4.3.7 MS Manual Control (The MS MANUAL CONTROL window is available on PurIon 
equipped systems only).

MS > Manual Control MS MANUAL CONTROL allows the fluid interface carrier solvent 
pump to be run for priming and to purge the carrier solvent. It 
can also be used for troubleshooting. 
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Figure 4-21Mass Spectrometer Manual Control window 

• Start Carrier Pump- Turns the carrier pump on for 
priming or to replace one carrier solvent with another 
one. A purge is complete in about 5 minutes. The button 
is replaced by STOP CARRIER PUMP when the pump is 
running. 
 
To prime the pump, open the priming valve on the fluid 
interface counterclockwise. Use the 5 mL Luer lock 
syringe provided with the accessory kit to draw liquid 
into the pump. Repeat this procedure once more to 
completely fill or purge the line from the carrier solvent 
reservoir to the priming valve. Make sure the priming 
valve is tightly shut after priming the system.

• Stop Carrier Pump- Stops the carrier pump. This is 
replaced by START CARRIER PUMP after the pump is 
stopped.

• Operate Splitter Valve- Runs the splitter valve to 
verify operation.

• Fluid Interface Pressure - The carrier solvent 
pressure is displayed in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow good response.

• Close - Closes the window and stops the carrier pump if 
it is running.

4.3.8 MS Ionization Settings (The MS IONIZATION SETTINGS window is available on PurIon 
equipped systems only).

MS > Ionization Settings IONIZATION SETTINGS provides settings to improve the ionization 
of a particular compound by reducing fragmentation or adduct 
formation.
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Figure 4-22Mass Spectrometer Ionization Settings window 

• Mass Spectrum Graph - Displays the mass spectrum. 
There are two mass spectra displayed. Blue displays the 
maximum of the current injection. Red displays the 
maximum of the previous injection for comparison. 
When a new injection is performed, the blue spectrum 
replaces the red spectrum, and a new blue spectrum is 
started. To inject a sample, move the PurIon injection 
valve to the “Inject Sample” position. 
 
Inject the sample (20 µL) and move the valve to the 
“Scan Mass” position.

Note
Only use 22 gauge square tip needles (PN 29-9001-911) to 
avoid scratching the internal surfaces of the injection valve. Fil-
ter the sample with a 0.45 µ filter to avoid clogging the PurIon 
tubing and probe capillary. Sample concentration should be 
less than 20 µg/mL.

• Polarity - Switches the mass spectrometer between 
positive and negative polarity.

Note
The PurIon S and L systems capture both polarities. The set-
ting changes which polarity is displayed.

• Format Graph- Sets the displayed range of the mass 
spectrum. The PurIon system still collects the entire 
mass range even when the range is set within than the 
minimum and maximum values allowed for the 
spectrometer. Values can range from 50 to 1200 Da 
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(PurIon and PurIon S) or 2000 Da (PurIon L). Changing 
the mass range defined by these controls may cause the 
Y-axis (ion count) scaling to change on the basis of the 
tallest peak within the range.

• Fluid Interface Pressure - The carrier solvent 
pressure is displayed in a ribbon gauge. If the pressure 
approaches the level of the red line, the system is 
clogged and should be cleaned to allow proper operation.

• Ion Settings - Allows selection of different ion settings 
to maximize the intensity of a molecular ion. The factory 
selections include “Robust” for compounds that do not 
easily ionize. “Typical” works well for most compounds. 
The “Fragile” setting is used for those compounds that 
are delicate or easily fragment. Settings that you define 
may also be loaded.

• Make Changes - Allows changes to settings to improve 
the intensity of an ion.

• Save - Saves changes to an existing ion settings file.

• Save As - Saves changes and create a new ion settings 
file. This new file can be selected in ionization settings 
or method development. Additionally, this file can also 
be selected when setting up a separation run.

• Factory Settings - Restores the “Typical”, “Robust”, 
and Fragile” ion settings to the factory default values.

• Probe - The probe nebulizes and ionizes the sample. 
Choose between ESI (electrospray interface) or APCI 
(atmospheric pressure chemical ionization) probes. The 
software changes the labels on the control to reflect the 
probe installed in the mass spectrometer.

• Gas Temp - The temperature of the nebulization gas for 
the probe. Lower temperatures are used for more 
delicate, heat-labile compounds. The temperature is set 
to quickly evaporate the carrier solvent. (Note that 
PurIon S and PurIon L systems display a single 
temperature for both positive and negative ionization).

• Voltage (Current) - Displays a voltage setting (ESI 
probes) or current value (APCI probes). Lower values 
are used for more delicate compounds. 
 
The capillary is heated to complete the evaporation of 
solvent. It also carries a voltage; lower voltages are used 
for more delicate compounds.

• Source Voltage - Source voltage settings have the 
greatest effect on fragmentation. Higher values induce 
more fragmentation but also reduce adduct formation.

• Offset - The voltage applied to all masses. Large values 
tend to increase fragmentation but reduce adduct 
formation.
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• Span - Span voltage defines an increased voltage 
applied as the mass increases. As with the offset, larger 
values increase fragmentation.

• Close - Closes the window.

4.3.9 Manual Control MANUAL CONTROL can assist with method development, mainte-
nance of the system plumbing, and system troubleshooting. For 
examples, see 5.4.2  Quick Cleaning when Recommended and 
5.4.3  Monthly Flow Cell Cleaning.

Tools > Manual Control

• Solvent Selections – (Solvent Selector Valve module 
only.) Selects the solvent to pump during manual pump 
operation.

• Percentage Solvent B – Type or select the mixture 
percentage.

• Flow Rate – Type or select the pump’s flow rate in 
mL/min.

• Pump into Tube # – Collects solvent in a tube that you 
choose. This can be useful when trying to recover a 
compound that has precipitated or “crashed” somewhere 
in the fluid path. By default, solvent is pumped to the 
waste port during manual control. If you want to collect 
the solvent in a tube, select the button next to PUMP 
INTO TUBE to enable it, then enter the tube number.

• Prime A – Pumps 100% of solvent A at the selected flow 
rate.

• Prime B – Pumps 100% of solvent B at the selected flow 
rate.

• PRIME XX% B – Pumps a mix of Solvent A and B.

• STOP – Stops the pump. This button is only available 
while the pump is running.

The raw lamp energy display can be used to verify flow cell clean-
liness. If the energy is low, it can be monitored while pumping a 
solvent to clean the flow cell. Select CLOSE MANUAL CONTROL to 
close the window.
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4.3.10 Automation Manual 
Control

This opens the Automation Manual Control window, which can 
be useful in flushing different portions of the AutoIn-
jector/AutoSampler flow paths by choosing the flow path, fluid 
source, and the amount of fluid to be pumped by the AutoInjector. 
It can also be used to prime the wash station.

Tools> Automation Wash 
Control

d

Figure 4-23The Automation Manual Control window

To prime the wash station:

1. Verify that the wash station supply line is placed into a 
suitable solvent (typically the strong chromatographic sol-
vent) and that the waste line is routed to a suitable con-
tainer.

2. Select START WASH to begin the priming process. Be sure 
that the wash solvent is pumped into the center portion of 
the wash station and that the fluid drains into the overflow 
drain when the station is full.

3. After the wash station is primed, select STOP WASH.

4.3.11 Large Sample Manual 
Control

The large sample load pump provides a convenient way to load 
and concentrate dilute samples.

Its window can be opened from the TOOLS menu. It is also 
available when SAMPLE OPTIONS > SAMPLE TYPE is “Large 
Sample”. The option is even present when the pump is turned 
off—no reboot is required after the pump is powered back on. 
Removal of the loop is unnecessary.

Tools> Large Sample 
Manual Control
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• Flow Rate – Type or select the pump’s flow rate in 
mL/min. 

• Pump Volume – Type or select the pump’s volume in 
mL, or choose UNLIMITED.

· UNLIMITED – The pump runs until you stop it; you 
could run the pump until all of the sample is 
collected. Afterward, you can CLOSE and continue 
with the injection.

4.3.12 Network Configuration 
Options

Network configuration, while useful, is not required for basic 
configuration.

Network configurations settings require assistance from your 
network administrator. Contact your Information Technology 
department before changing the settings. For more information 
about networking, see TN28 Networking Guidelines for Combi-
Flash Products available at www.teledynelabs.com. 

Tools > Configuration Network Configuration – The CONFIGURATION window groups 
its settings under tabs. The NETWORK tab is described below. 
(The other tabs are covered in Section 2.1  Configuration of the 
ACCQPrep.)

Instrument IP Address Configuration. Use these settings to 
specify the instrument’s network address and its parameters:

• Network Type - STATIC IP or DHCP.

· STATIC IP requires an IP address, netmask, and 
gateway provided by your network administrator.

· DHCP retrieves the IP address, netmask, and 
gateway from a DHCP server.

• IP Address - The static IP address for the system. 
(Available when NETWORK TYPE is STATIC IP.)

• Netmask - The netmask for the system. (Available 
when NETWORK TYPE is STATIC IP.)

• Gateway - The gateway for the system. (Available when 
NETWORK TYPE is STATIC IP.)

• DNS Server - The domain name server for your 
network. Enter an address if you use a domain name 
server to translate domain names to IP addresses. 
(Available when NETWORK TYPE is STATIC IP.)

Network Printing. The system can print to a network printer, 
and it supports JetDirect and line printer (LPR) queues when 
configured.

Consult with your network administrator to determine these set-
tings:

• The IP address of selected printer.

• The queue name, if the printer uses an LPR print queue.

• The port number, if the printer uses a JetDirect print 
queue.

• The printer type: either PostScript or PCL.

https://www.teledynelabs.com/en-us/resources/Documents/Technical-Notes/Networking-Guidelines-For-Chromatography-Products.pdf
https://www.teledynelabs.com/en-us/resources/Documents/Technical-Notes/Networking-Guidelines-For-Chromatography-Products.pdf
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When this information is known, you can proceed with config-
uring system for network printing.

Follow the on-screen instructions for entering the address, 
queue, and printer type information. After successfully printing 
a test page, the network printer will be available for printing by 
choosing FILE > PRINT from the menu and the AUTOMATICALLY 
PRINT AT END OF RUN feature.

Network File Save Configuration. When configured, this 
feature allows the system to access a network directory from 
which it can save run files as PDF, text, or run monitor. To enable 
this feature, select a file type to be saved and enter the 
remaining settings necessary for network access. Your network 
administrator can provide the required settings.

Note
All server and domain names must be fully qualified. That is, 
entries must include the full name (server name.domain.domain…). 
Use forward slashes (/), not back slashes, when entering the net-
work share path.

4.3.13 Set Administrator 
Password

This window, opened by selecting TOOLS > SET ADMINISTRATOR 
PASSWORD from the menu, is used to enter and change the 
system password.

Tools > Set Administrator 
Password

To enter or change a password:

1. Type the password. The factory default password is 
“accqprep”.

2. Type the new password.

3. Type the password again to verify your entry.

4. Select OK to save your settings and close the window.
The following commands require a password before displaying 
the requested window:

• TOOLS > USER MANAGEMENT

• HELP > SERVICE

• TOOLS > SET ADMINISTRATOR PASSWORD. This protects 
the current password.

4.3.14 User Management User Management – Opens the USER MANAGEMENT 
window, from which you can add or remove users from the 
system and to change passwords. To prevent unauthorized 
changes to user management, this function is password 
protected.

Tools > User Management • To add a user, select ADD NEW and enter the user name 
in the window that appears. Another window will 
appear into which a password for the new user can be 
entered. Leave the field empty if no password is needed. 
When you add a user, a working folder for that user is 
automatically created. When they log in, their data files 
will automatically be stored in their user folder. It will 
be reset when logging out.  Use FILE > SET DATA PATH to 
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select your folder. To prevent unauthorized changes to 
user management, this function is password protected.

• To delete a user, select the DELETE button next to the 
user’s name and confirm the action. 

• To change a password for a user, select CHANGE 
PASSWORD. 

• To delete a password, leave the text box empty.
After users are created, they can be assigned access levels for the 
system (Figure 4-24).

Figure 4-24Table of user level access

4.4 Examples of PeakTrak 
actions

In this section you will find instructions for typical PeakTrak 
tasks, such as:

• editing a default method (Section 4.4.1),

• creating a method file in other ways (Section 4.4.2),

• defining a gradient (Section 4.4.3), 

• real-time gradient editing (Section 4.4.4),

• bypassing the injection loop (Section 4.4.5),

• monitoring the purity measure (Section 4.4.6),

• viewing runs (Section 4.4.7),

• controlling the ACCQPrep manually (4.4.8).
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4.4.1 Editing a method Editing a method allows you to tailor the operation of the 
ACCQPrep system to best separate or purify the compounds of 
interest.

PeakTrak has two types of method settings: basic and advanced.

Basic Method Settings Basic settings allow you to control the %B gradient mix, flow 
rate, solvents, and run length. These settings are part of the 
MAIN window and are the most frequently changed settings 
when developing or improving purification methods.

The %B gradient mix and run length are shown on the plot area. 
Refer to Section 4.4.3  Defining a Gradient for details.

Other settings:

• Flow Rate — This defaults to the value created when 
setting up the HPLC column but can be changed for 
each separation if desired.

• Solvent A and B — Select solvents from the lists. Listed 
solvents are those defined by the CONFIGURATION 
window.

Advanced Method Settings The METHOD EDITOR window gives you access to advanced set-
tings such as EQUILIBRATION volume, INITIAL WASTE, air purge, 
PEAK DETECTION, and the PEAK COLLECTION mode.

See Section 4.3.4 for detailed information about METHOD EDITOR
window settings. Some highlights:

• EQUILIBRATION VOLUME COLUMN — equilibration is 
optional, but you may find that separations are more 
effective if the column is equilibrated before injecting 
the sample. 

• INITIAL WASTE & TIME WINDOWS — The initial waste 
diverts a user-determined volume to the waste port until 
the eluent is about to be collected. At the start of a run, 
the internal solvent lines hold some solvent from the 
previous run. This volume can be diverted to waste, 
along with the anticipated volume of fluid that will pass 
through the column before a compound of interest will 
elute.
Time Windows can limit the fraction collection to specific 
time durations of the run.

• PEAK COLLECTION — There are three peak collection 
settings: All, Peaks, or None.

· ALL collects peak and non-peak fluid in tubes.

· PEAKS collects only peak fluid in tubes and divert all 
other fluids to the waste port. NONE diverts all 
fluids—peak and non-peak—to the waste port.

· NONE is useful for developing custom methods that 
perform a column wash, system cleaning, or similar 
function where solvents and elute do not need to be 
collected.

When using the ALL or PEAKS options, you can specify the 
maximum peak and non-peak volumes to be collected in the 
tubes. Be sure to enter volumes less than the maximum tube 
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capacity. Different peak and non-peak tube volumes can be used 
to conserve tubes when using the All peak collection mode by col-
lecting large volumes of non-peak fluid while creating more, 
smaller fraction volumes of fluids of interest.

The fraction collector advances to the next tube whenever a peak 
is detected. Also, the system advances to the next tube if a new 
peak is detected before completing the last one (sometimes called 
a double advance). Tubes may also advance when using multiple 
detectors, depending on impurities or sensitivity to a given com-
pound by each detector. Keep in mind that the slope and 
threshold detection methods use algorithms which optimize the 
peak detection. For example, peak detection includes a hysteresis 
to reduce the likelihood of multiple tube advances that may occur 
if there is noise at the beginning or tail end of a peak.

You can also set

• TUBE VOLUME for collected fluids. This volume can be 
the default maximum volume for that tube size (Max 
option) as entered in the CONFIGURATION window, or a 
method-specific volume that is less than the capacity 
defined by the CONFIGURATION window.

• PEAK DETECTION options. When an option is selected, 
the window also allows you to modify the setting details 
for that peak detection option. All enabled options are 
displayed on the chromatogram.

Note
You can select up to four peak detection options (excluding the 
External option) on the ACCQPrep systems. If using more than 
one option, such as 1 with  2, the system considers a peak 
to be present when either option is true (a logical OR).

Peak detection options include: 

• 1 and 2 (wavelength 1 and 2): Provides primary and 
secondary wavelength detection. When enabled, type or 
select the peak detection wavelength in nanometers, 
then select DETAILS to configure additional settings, 
including SLOPE and THRESHOLD peak detection.

Note
If both Slope and Threshold peak detection methods are 
checked, the system considers a peak to be present when any 
one condition is met. This logical OR operator means that the 
system cuts a peak when either the Slope condition is true or 
when the Threshold condition is true.

• All Wavelength Detection: Detects peaks within a 
user-selected range of wavelengths. When enabled, 
select DETAILS to configure additional settings. These 
settings include the slope-based and peak width options 
described in 1 and 2 above. Additionally, you can type 
or select the minimum and maximum wavelengths 
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limits in nanometers. PEAK WIDTH for All Wavelength 
Detection also determines the length of time before an 
automatic auto-zero of baseline occurs. This period is 
twice the peak width setting.

• External Detector: Uses a 0 to 1 volt analog input signal 
from an external detector. When enabled, select DETAILS 
to configure additional settings. These settings include 
the slope-based and peak width options described in 1 
and 2 above. The system uses its internal algorithms to 
cut detect and cut peaks on the basis of the analog input 
signal. Refer to the External Detector instruction sheet 
for cable and plumbing requirements.

• ELS Detector: The evaporative light scattering (ELS) 
detector on an ACCQPrep system.

• Mass Spectrometer (PurIon systems only): Monitors or 
detects compounds with a PurIon mass spectrometer 
system.

• Purity Measure: Displays a ratio of the selected 
wavelengths if two absorbance wavelengths are used. 
The ratio trace is often a useful indicator of purity. 
Select SHOW SPECTRAL PURITY to measure purity by 
using a comparison of UV-spectra measured at differing 
times as a purity measurement. Select SPECTRAL 
PURITY DETECTION for fractionation based on spectral 
purity. 

Selecting PEAK DETECTION DETAILS opens additional detector 
options for 1 and 2, ALL WAVELENGTH DETECTION, MASS SPEC-
TROMETER, ELS DETECTION, EXTERNAL DETECTION, and PURITY 
MEASURE peak detection. See Section 4.3.4 for detailed infor-
mation about peak detection settings. 

Saving Changes to the Method File – After you have 
edited the method file, you can save the changes for future 
use. Select SAVE AS, give the method file a descriptive 
name, then select SAVE. The method file is stored by the 
ACCQPrep system and will be available for future runs.

4.4.2 Alternative Ways to 
Create Method Files

There are other ways to create method files besides editing them 
on the ACCQPrep system:

Importing Method Files from another System –  If a 
method file is located on another ACCQPrep system, you 
can use FILE > EXPORT METHOD to save the method file on 
an external storage device. From the touchscreen, this stor-
age device is a USB flash drive connected to the USB port 
below the display. If you are accessing system via an Inter-
net browser, the storage device may be any device that can 
be accessed by the local computer. 
To move the method file onto the system, insert the USB 
flash drive into the USB port or connect to the system from 
the remote computer, then use FILE > IMPORT METHOD to 
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locate and import the method file.
Extracting a Method File from a Previous Run – After 

the run, you can extract the run parameters as a method 
file so it can be used on future runs. To do so, open the Run 
file, then select EXTRACT. The system loads a new method 
with identical run parameters. You can then save the 
method using FILE > SAVE METHOD AS.

4.4.3 Defining a Gradient The simplest way to change the gradient is to select and drag the 
inflection points that define the shape of the gradient. Add a 
point by selecting the INSERT button, then select the gradient 
curve to add a point. You can then drag the new point to the 
desired location. Delete a point by selecting the DELETE button 
and then selecting the undesired inflection point.

The methods described above work in the MAIN window and 
METHOD EDITOR WINDOW. Alternatively, you can modify, add, 
insert, and delete points using a tabular view on the METHOD 
EDITOR window. Select the EDIT GRADIENT button to toggle the 
gradient table, then use the controls to modify the settings. 
Selecting EDIT GRADIENT again closes the table view. (See 
Section Method Editor: Edit Gradient)

4.4.4 Real-time Gradient 
Editing

The gradient shape can be changed during the run. Any time 
after the fraction collector has positioned the drop former over 
the first tube, select and drag the points on the gradient plot area 
of the MAIN window. You can also add or remove points by 
selecting the INSERT or DELETE point buttons. INSERT allows you 
to add a single point where you select it on the gradient profile. 
Repeat this action to add more points. DELETE allows you to 
remove a single point when you select it.

Note
Only the portion of the gradient that has not yet occurred 
during the run can be modified.

4.4.5 Bypassing the 
Injection Loop

BYPASS LOOP button overrides the position of the Prep injection 
loop. During normal operation the loop is placed into the flow 
path ahead of the column after the equilibration is completed. It 
remains in this position for the remainder of the separation. This 
feature allows you to remove the loop from the flow path and is 
useful for manually stacking injections when doing an isocratic 
separation. It requires you to perform sufficient method devel-
opment to know when all of the compounds elute from the 
column.

For example, assume that a separation is developed with two 
compounds that elute at 5 and 10 minutes. At the 5 minute point 
of the separation, the sample loop can be removed from the flow 
path and loaded with another sample of the same materials. The 
loop can then be placed into the flow path at the 6 minute point. 
In this scenario, the first compound will elute at 5 minutes, the 
second compound will elute from the column at 10 minutes. The 
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first compound in the second injection will elute at 11 minutes (6 
minute injection time plus 5 minutes to elute), and the second 
compound from the second injection will elute at 16 minutes.

In this example, the two injections can be separated in 16 
minutes instead of 20 minutes. The process can be repeated as 
needed in increase system throughput. While isocratic separa-
tions may typically be slower than a gradient separation, you are 
also able to eliminate the time required for column equilibration 
after a gradient separation.

4.4.6 Monitoring the Purity 
Measure

When using two wavelength detection options, a ratio of the two 
wavelengths can also be displayed which at times can provide the 
best indication of compound purity. Consider the following:

If a pure compound is eluting, the absorbance is linearly related 
to the concentration of the compound in the solvent. If the com-
pound absorbs differently at different wavelengths, the absor-
bance at each wavelength may be different but still linearly 
related. For example, assume that a compound eluting from the 
system has an absorbance equal to 2 times the concentration at 
254 nm. This same compound at 220 nm has an absorbance of 1.5 
times the concentration. The ratio of these signals is 1.33. Since 
the relationship of absorbance to concentration is not variable, 
the ratio remains steady while the concentration changes from 
the beginning to the end of the peak. During the duration of the 
peak, the ratio will be 1.33, and this constant value is displayed 
as a horizontal line.

Now assume that there is a second compound eluting, only 
slightly shifted in time from the original compound. It is possible 
that the detection absorbance trace alone would indicate a single, 
valid chromatographic peak. In reality, it is a combination of two 
peaks. By monitoring a second wavelength, it may be possible to 
reveal the second compound. Because of the slight shift in time 
and the different absorbance properties of the two compounds, 
the changing ratio during the detected peak would reveal the 
impurity. Therefore, you can assume that if the ratio is not con-
stant for the entire duration of the peak, the compound eluting 
may not be pure.

The following controls can be found on the PURITY MEASURE 
window (METHOD EDITOR > ALL WAVELENGTH DETECTION > 
DETAILS >).

• SHOW SPECTRAL PURITY measures purity by using a 
comparison of UV-spectra measured at differing times. 
The algorithm used is the “similarity index.”

• SPECTRAL PURITY DETECTION allows fractionation based 
on spectral purity. However, the spectral purity 
algorithm doesn’t work on saturated peaks (flat on top 
due to detector saturation).

• SHOW RATIO displays the ratio when using two absor-
bance wavelengths.
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4.4.7 Viewing runs After completing a run, the PeakTrak MAIN window is used to 
display all collected run data. You can also open previous runs to 
view the chromatogram and the peak/tube locations. To open a 
previous run:

1. From the MAIN window, select FILE > OPEN, or select the 
OPEN button. The FILES window is displayed.

2. Choose a Run file and select OPEN. PeakTrak displays the 
run in the RUN VIEWER window, which includes the follow-
ing:

• Rack and tube information — The left pane of the 
window lists the current rack, a map for that rack, and a 
table that lists the peaks and their corresponding tube 
numbers. If the window is currently displaying the 
collection parameters, select DISPLAY RACK to view this 
information. On PurIon equipped systems, the mass 
spectrum of the fraction contents can be displayed by 
selecting MS button and selecting on a tube.

• Method parameters — DISPLAY METHOD displays 
summary of the peak detection and collection settings 
for the run.

• Chromatogram — Displayed on the right side and 
identified by the sample name in the window’s title bar.

• OPTION buttons — Quickly access frequently used 
commands while viewing a run:

PRINT — Prints a run summary. When viewing 
the run from a remote personal computer, the 

summary can be printed on any installed printer. If you 
are attempting to print from the systems touch panel 
display, you must first set up NETWORK PRINTING in the 
NETWORK CONFIGURATION settings.

Save As PDF — Saves the run summary as a 
PDF file. When viewing the run from a remote 
personal computer, the summary can be saved to 

any connected storage device. If you are attempting to 
save a PDF file from the touch panel display, insert a 
USB Flash drive in the USB port below the display 
panel.

SAVE AS TXT — Saves the run summary as an 
ASCII text file. When viewing the run from a 
remote personal computer, the summary can be 

saved to any connected storage device. If you are 
attempting to save a TXT file from the touch panel dis-
play, insert a USB Flash drive in the USB port below 
the display panel.

• Use pinch zoom or pan to view the results screen in 
greater detail. Panning requires the use of two fingers to 
differentiate it from selecting.

• FORMAT GRAPH — Opens a window from which you can 
set the left and right Y-axis scales. These scales are 
controlled by the absorbance and %B upper limits. 
Selecting the SHOW THRESHOLD LEVEL button shows the 

PDF

T
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threshold level setting of all detectors except the mass 
spectrometer. The threshold levels are color-coded to the 
detector trace.

• REFERENCE CHROMATOGRAM — Pulls up a previous run 
to compare to current run. Time scale matches the 
longest run. If runs are of different lengths, then the 
shorter run will be missing that part of the 
chromatogram. Also, zooming on one spectrum scales 
the other spectrum similarly.

• MS — Displays a mass spectrum (PurIon systems only). 
Selecting in the Chromatogram window displays a mass 
spectrum at that point during the run. Selecting on a 
tube in the rack map shows the mass spectrum of the 
contents of that fraction.

• STACK INJECTIONS — Opens the STACK INJECTIONS 
window, from which time windows can be adjusted. See 
Section 3.3.10  Stacked Injections.

• UV — Displays a UV spectrum. Selecting in the 
chromatogram window displays a mass spectrum at that 
point during the run. On UV-Vis equipped systems, this 
is displayed as “UV-Vis” and displays UV-visible 
spectrum.

• EXTRACT — Loads a new method file on the basis of the 
parameters for the run you are viewing.

• CLOSE — Closes the Run File window.
General instructions for reading the data – Most ele-

ments on the window are color-keyed to help you locate the 
tubes containing the peaks of interest. A color bar below 
each collected peak matches a tube in the map on the left. 
The tube map provides a visual representation of the tubes 
that contain the peaks of interest. If you want to identify 
the tube by number, refer to the table below the rack dia-
gram. 
 
If the run used multiple racks, PREVIOUS and NEXT RACK 
buttons are available. Select them to scroll through the 
available racks. The currently displayed rack is identified 
by letter which is shown below the rack.
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Reading the Chromatogram – The plot area displays the 
following:

· The red absorbance trace produced by the system’s 
peak detector. Absorbance units (also shown in red) 
that correspond to this trace are shown on the left 
Y-axis.

· Purple absorbance and green purity measurement 
traces that may be visible if you are monitoring a 
second wavelength.

· Green traces from ELSD or external detectors.

· PurIon traces color coded with the selected masses 
below the graph Y-axis.

· The blue gradient curve that was used during the 
run. The % Solvent B scale is shown in blue on the 
right Y-axis.

· The X-axis depicts the run time, shown as minutes.

· Vertical lines that appear at intervals along the 
X-axis. These lines indicate collection tube changes. 
To prevent the plot area from being obscured by tube 
change marks, PeakTrak may limit the number of 
marks.

4.4.8 Manual Control of the 
ACCQPrep 

MANUAL CONTROL assists with method development, mainte-
nance of the system plumbing, and system troubleshooting. To 
manually control the ACCQPrep system, first go to TOOLS > 
MANUAL CONTROL.

Pumping Solvents To pump either solvent, select the solvent from the Solvent A or 
Solvent B lists. Then, select PUMP A or PUMP B to pump the 
selected solvent. To pump a mixture or Solvent A and B, adjust 
the Percentage Solvent B setting and then select PUMP% B. 
When finished, select STOP.

You can control the flow rate by adjusting the FLOW RATE 
ML/MIN.

By default, the system pumps the solvent directly to the waste 
port, you can also pump the solvent into a collection tube. Select 
PUMP INTO TUBE #, then select which tube (“Next” or a specific 
tube number).
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Raw Lamp Energy The left side of the MANUAL CONTROL window shows a RAW LAMP 
ENERGY gauge. This provides an indication of the UV light mea-
sured by the optical detection system at 254 nm. High lamp 
energy (green) means that the flow cell easily passes through a 
sufficient UV light source. Lower lamp energy (yellow or red) 
means that either the light source is weak or that the flow cell is 
obstructed.

• Green – lamp energy is sufficient to detect peaks up to 
2.4 Absorbance Units.

• Red – lamp energy is obstructed to a degree that the 
system might not reliably detect peaks. If you attempt to 
operate the system, peak collection will be forced to 
collect all. This prevents diverting desired compounds to 
waste.

Depending on what you are doing with the MANUAL CONTROL
functions, low lamp energy could be a normal indication. For 
example, a UV-absorbing compound could be present in the flow 
cell as you are pumping solvent. Or, the selected solvent absorbs 
UV light at 254 nm. Abnormal indications could be a flow cell 
blocked by a compound that has precipitated, or there is a film 
built up on the flow cell. See 5.4.2  Quick Cleaning when Recom-
mended for more information about the Raw Lamp Energy gauge 
and flow cell cleaning.
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ACCQPrep HP150

Section 5  Maintenance 

5.1 Introduction This section covers some common maintenance routines for the 
ACCQPrep HP150. 

5.1.1 Cleaning To clean the exterior surfaces, use a cleaning cloth dampened 
with a mixture of distilled water and a mild detergent. Use iso-
propyl alcohol for tougher stains.

On printed areas such as labels, avoid rubbing vigorously or 
using aggressive solvents like acetone. These will ruin the 
printed text.

CAUTION
Do not immerse the instrument in a water bath or subject it to a 
liquid spray. The instrument is not watertight, and these actions 
could damage the internal electronics.

5.1.2 Collection Rack and 
Tray Cleaning

WARNING
Risk of fire or equipment damage. Unclean collection racks 
and tray might have inhibited conductive properties. The 
racks and tray must be kept clean to dissipate static 
electricity.

The collection tube racks and tray are made of conductive plastic. 
Dirt, film, or coatings might prevent their ability to dissipate 
static electricity. To avoid problems that could result from an 
electrostatic discharge, clean the racks and tray monthly. Use 
distilled water with a mild detergent. For tougher stains, use iso-
propyl alcohol.

5.2 System Standby and 
Shut Down

During extended periods of inactivity, you can place the system in 
STANDBY to conserve power. To do so, log off the system (FILE > 
LOG OUT) and place the  On/Standby switch in STANDBY.

When in the STANDBY state, normal system operation is no 
longer available from the touchscreen or remotely. However, 
some internal components are still powered.

WARNING
As long as the AC mains power cord is connected, power 
is inside the unit. The mains power cord is the disconnect 
device. Position the ACCQPrep system so that the power 
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cord can be unplugged, or use a power strip where the plug 
can quickly be removed from the outlet in the event of an 
emergency.

When you first place the system in STANDBY, internal compo-
nents continue to operate for almost one minute while per-
forming file maintenance and preparing the system for possible 
power removal.

CAUTION
Removing the AC mains power cord before the file mainte-
nance is complete might corrupt files on the internal hard drive. 
These corrupted files can cause abnormal operation or a com-
plete system failure that requires service. Unless power must 
be removed due to an emergency, always wait at least one 
minute after placing the system in STANDBY before removing 
the AC mains power cord.

5.2.1 Tubing Inspection

WARNING
Risk of fire or equipment damage. Faulty tubing, fittings, 
and drains may allow organic solvents to pool in unsafe 
areas, creating a potential for dangerous levels of 
flammable vapors. Improper draining may damage the 
instrument’s internal components.

Perform a tubing inspection monthly:

1. Visually inspect the solvent, waste, and drain tubing. The 
tubing must be free of any damage, kinks, or deterioration. 
Fittings must show no signs of leaks.

2. Test the collection tray drain by connecting a vacuum or air 
supply source to the outlet end of the drain tubes. Then, 
verify the presence of such vacuum or air supply source on 
the drain hole (Figures 5-1).

Correct any deficiencies before returning the instrument to oper-
ation.
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Figure 5-1 Fraction collection tray drain hole

5.3 Preventive 
Maintenance

The system requires preventive maintenance for safe and 
reliable operation. Refer to the schedule below for the minimum 
periodic maintenance requirements.

As Needed  – Perform these tasks as conditions require:

• Cleaning (Section 5.1.1).

• Quick flow cell cleaning when recommended by a system 
alert message (Section 5.4).

• Wipe the cone on PurIon system with a wipe soaked 
with methanol or water to remove visible residue near 
the cone inlet. (PurIon systems only).

Every Run  – Perform these tasks at the end of each run:

• Allow the separation run to finish with a high 
percentage of solvent B to flush residual compounds 
from the column, internal tubing, and flow cell. Refer to 
section 5.4.

• Allow the Cone wash to run to completion (PurIon 
systems only) to wash residual compounds from the 
fluid interface, probe, and to clean the cone area.

• Allow the Valve Wash sequence to run to completion to 
wash residual compounds from the injection valve and 
ELSD (if installed) flow path.

Monthly – Perform these tasks at least monthly, more fre-
quently if conditions warrant:

• Tubing Inspection (Section 5.2.1).

• Collection rack and tray cleaning (Section 5.1.2).

• Monthly flow cell cleaning (Section 5.4.3).
Annually  – Perform these tasks at least annually, more fre-
quently if conditions warrant:

• Change roughing pump oil (PurIon systems only). 

Vacuum or pressurized air 
applied to the outlet end of 
the drain tube must be 
present at the collection 
tray drain hole.
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5.4 Flow Cell Cleaning

5.4.1 Post Separation As a preventive measure, all default column methods finish the 
separation run with a high percentage of solvent B (Figure 5-2). 
This brief time (one to six column volumes) of strong solvent 
flushes residual compounds from the column, flow cell, and 
internal tubing.

Figure 5-2 Default post-separation column and flow cell 
flush

Skipping the post-separation flush may cause residual com-
pounds to build up and crystallize, which might result in

• cross contaminating later separation runs,

• higher operating pressures,

• reduced flow cell lamp energy,

• a noisy baseline on the absorbance trace, and

• frequent messages recommending flow cell cleaning 
(Figure 5-3).

Typically, chemists STOP and then TERMINATE the run after the 
last compound elutes. This action skips the post-separation flush. 
If any of the conditions listed above appear, consider allowing 
some of the runs to continue through the flush, or run a high per-
centage of %B solvent through the system for a few minutes at 
the end of each day.

If the separation runs always continue through the flush and the 
conditions still occur frequently, edit the DEFAULT COLUMN 
METHODs to extend the flush duration.

CAUTION
Do not use polar, basic solvent systems with silica column 
media. These solvent systems may break down the silica 
structure, possibly causing obstructions in the flow path. 
Examples of such solvent systems include, but are not limited 
to, those containing more than 20% methanol with ammonia.
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5.4.2 Quick Cleaning when 
Recommended

When the lamp energy is lower than normal, the system will rec-
ommend flow cell cleaning (Figure 5-3) before starting a sepa-
ration run. You can then choose one of the following:

• Cancel Run (recommended) – Perform a quick cleaning 
described in the following steps.

• Continue Collect All – Ignore the message. Because 
the peak detection operation might be impaired, the 
system automatically collects all fluids to avoid 
diverting compounds of interest to waste.

• Help – Display the flow cell cleaning on-line help topic.
To perform a quick cleaning:

1. After CANCEL RUN, select the TOOLS > MANUAL CONTROL. 
The MANUAL CONTROL window opens.

2. Note the Raw Lamp Energy level at 254 nm. The Raw 
Lamp Energy gauge has two ranges: red and green (Figure 
5-3).

Figure 5-3 Raw lamp energy gauge 

• Red – Lamp energy is obstructed to a degree that the 
system might not reliably detect peaks. If you attempt to 
operate the system, peak collection will be forced to 
collect all. This prevents diverting desired compounds to 
waste.

• Green – Lamp energy is sufficient to detect peaks 
within typical system limits.

3. Remove the column and insert a union between the tubing. 

4. Set the Flow Rate to 40 mL/min (Figure 5-4).
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Figure 5-4 Manual Control Settings - Quick Cleaning

5. Select THROUGH HPLC COLUMN for the FLOW PATH option.

6. Select NEXT for the Pump into Tube # option. By pumping 
into a collection tube, the diverter valve is also cleaned of 
any residue during this operation.

7. Select PUMP SOLVENT B to pump 100% Solvent B through 
the bypass tube and into the collection tubes.

Note
Pumping solvent B at a moderate flow rate (25 to 45 mL/min) 
overtime usually solubilizes obstructions. Generally, the rec-
ommended solvent is the highest polarity solvent you have 
recently used (solvent B).

8. Monitor the Raw Lamp Energy gauge. As the system 
pumps solvent, the raw lamp energy should gradually 
improve. Pump solvent for two to five minutes or until the 
indicator reaches the far-right of the green range.

If after five minutes the indicator is still in the red range, repeat 
the cleaning steps using an alternative solvent. Or complete the 
steps in the Monthly Flow Cell Cleaning procedure (section
5.4.3).

Note
If the numerical values of the Raw Lamp Energy (Figure 5-3) 
do not change, or if the first number remains at zero, contact 
Teledyn e ISCO’s  Te chn ica l  Serv i ce  de par tmen t .  

5.4.3 Monthly Flow Cell 
Cleaning

Perform this procedure as part of your scheduled preventive 
maintenance, or when QUICK CLEANING AS REQUIRED (section 
5.4.2) does not improve the lamp energy.

1. Remove the column and insert a union between the tubing.

2. From the menu, select TOOLS>MANUAL CONTROL. This 
opens the MANUAL CONTROL window.
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3. Set the Flow Rate to 40 mL/min.

4. Select THROUGH HPLC COLUMN FOR THE FLOW PATH 
option.

5. Select NEXT for the Pump into Tube # option.

6. Place the B1 Solvent inlet line into a reservoir of methanol, 
acetone, or a strong solvent that readily dissolves residual 
sample material.

7. Select PUMP SOLVENT B to pump 100% Solvent B through 
the bypass tube and into the collection tubes.

8. After three minutes, select STOP. Allow the system to stand 
for at least six hours. Overnight is recommended.

9. Return the B1 solvent line to the original solvent container.

10. Perform the QUICK CLEANING AS REQUIRED (Section 5.4.2 
and monitor the Raw Lamp Energy. (Figure 5-3) 
 
If the lamp energy is in the green range return the system 
to operation. If the lamp energy is red, contact Teledyne 
ISCO’s Technical Service department for assistance.

5.5 ACCQPrep HP150 
Maintenance

5.5.1 Injection Valve Rotor 
Replacement

The following instructions are for the removal and replacement 
of the injection valve rotor. (PN: 20-9009-917). 

ACCQPrep systems with a serial number starting with 218H or 
higher may have spare rotors included with the system. For 
these units, access the pump compartment by gripping the edges 
of the front panel and pulling forward on both sides (Figure 5-8). 
Inside the front cover an envelope contains spare rotors, a hex 
key needed for removal and a copy of the replacement instruc-
tions.

Note
The injection valve rotor is a common wear part and is there-
fore not covered under warranty. Since it is a sealing surface, it 
can be damaged by particulates in the sample. To prolong the 
life of the rotor, ensure your sample is properly f iltered 
(<20 µm) to prevent premature failure. Failure is evident by 
leakage from an unexpected port or location such as the sam-
ple load port after injection. 

Removing the Injection 
Valve Rotor

1. Use the supplied 9/64" hex key to remove the 2 screws that 
retain the stator (the portion of the inject valve with the 
tubing connections). Loosen these in quarter turn incre-
ments until the tension is removed and a gap starts to 
appear (Figure 5-5). 
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Figure 5-5 Location of the stator retaining screws 

2. Remove the screws and pull the stator outward. This may 
require a side-to-side motion until removed. 

3. When the stator is removed, use your finger or a small tool 
to pry the black plastic rotor out of its recess (Figure 5-6). 

Figure 5-6 Removing the rotor

4. Usually the failure mode is a visible scratch between the 
normal passages on the rotor.

Figure 5-7 Sealing surface of the stator 

Gap will
appear here

Screws

Rotor

Sealing surface
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5. Clean and inspect the stator sealing surface (which con-
tacts the rotor) for scratches. If this part is scratched, it 
may need replacement also. 

Installing the New 
Injection Valve Rotor

1. Place the new rotor into the recess with the  
passages facing outward. The tabs on the rotor are not 
symmetric, so the rotor only fits in one orientation.

2. Install the stator onto the locating pins and use a 
side-to-side motion until secure.

3. Install the screws evenly until spring force is felt. Then 
tighten the screws in quarter turn  
increments on each side until the stator contacts the valve 
body evenly. The rotor seal is accomplished by a spring so 
excessive screw torque is not necessary. 

5.5.2 Pump Seal 
Replacement

1. Turn off the power to the system. 

2. Access the pump compartment by gripping the edges of the 
front panel and pulling forward on both sides (Figure 5-8). 

Figure 5-8 Front panel of the ACCQPrep

3. Remove the two screws securing the pump assembly in 
place using the included 3/16" hex wrench.

4. Disconnect the solvent inlet lines from the pump inlet tees 
and disconnect the high pressure lines from the bulkhead 
fittings. 

5. Disconnect the cables from the pump assembly before pull-
ing it forward to avoid damage to the cables. Then, pull the 
pump assembly forward.

6. Remove the inlet fittings.

7. Remove the outlet fittings. 

8. Remove the two pump head fasteners. Use the supplied 
3/16" hex wrench (Figure 5-9). 
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Figure 5-9 Removing the fasteners

9. Carefully pull the pump head forward and off the guide 
pins. Pull straight and slowly to prevent damage to the pis-
ton (Figure 5-10). 

Note
The seal back-up washer may remain on the piston. Remove 
the washer from the piston if it did not stay in the pump head.

Figure 5-10Removing the pump head

10. Carefully pull the pump spacer block forward and off the 
guide pins. Pull straight and slowly to prevent damage to 
the piston. Also, remove the guide bushing from the piston 
if it did not stay in the pump spacer block (Figure 5-11).
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Figure 5-11Removing the pump spacer block

11. Insert the flanged end of the seal insertion/removal tool 
into the seal cavity on the pump head. Tilt it slightly so 
that the flange is under the seal, then pull out the seal 
(Figure 5-12).

CAUTION
Using any other tool will scratch the finish of the sealing sur-
face and create a leak.

Figure 5-12Removing the seals

12. Use the scouring pad included in the seal replacement kit 
to clean the piston. Gently squeeze the piston within a 
folded section of the pad and rub the pad along the length 
of the piston. Rotate the piston frequently to assure the 
entire surface is scrubbed. After scouring, use a lint-free 
cloth, dampened with alcohol, to wipe the piston clean 
(Figure 5-13).

Note
Do not exert pressure perpendicular to the length of the piston, 
as this may cause the piston to break. 
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Figure 5-13Cleaning the piston

13. Place a replacement seal on the rod-shaped end of the seal 
insertion/removal tool so that the spring (energizer) is visi-
ble when the seal is fully seated on the tool. Insert the tool 
into the pump head (Figure 5-14). 

Note
Be careful to line up the seal with the cavity while inserting.

Figure 5-14Replacing the seal

14. Carefully replace the pump spacer block, making sure the 
O-ring is properly installed (Figure 5-15). 
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Figure 5-15Reinstalling the pump spacer block

15. Place the seal back-up washer on the piston. Replace the 
pump head. Make sure that the inlet check valves are on 
the bottom and the outlet check valves are on top (Figure 
5-16).

Note
Push onto guide pins straight and slowly to prevent damage to 
the piston. Do not force the self-pump spacer block or pump 
head into place.

Figure 5-16Reinstalling the pump head

16. Reinstall fasteners. As you tighten, alternate side-to-side 
until snug. Turn 1 flat past snug using a 3/16" hex key (Fig-
ure 5-17).

Note
Be sure the Inlet Check Valve Housing is on the bottom and 
the Outlet Check Valve Housing is on the top.



ACCQPrep HP150 
Section 5   Maintenance

5-14 EAR99 Technology Subject to Restrictions Contained on the Cover Page

Figure 5-17Reinstalling the fasteners 

5.5.3 Seal Conditioning New seals must be conditioned prior to use. Conditioning is the 
process of running the seals wet under controlled conditions to 
allow surfaces to seat and break-in for proper function of the 
seal.

Note
Buffer solutions and salt solutions should never be used to 
condition new seals. Recommended solvents are HPLC-grade 
methanol or acetonitrile and water   

Suggested Conditioning 
Parameters

Using a suitable column, run the pump with a 50:50 solution of 
methanol/water for 30 minutes at a flow rate that results in a 
pressure of about 1000 psi. Then run the pump for another 15 
minutes at a flow rate that results in 3000 psi.

5.5.4 Check Valve 
Replacement

The following instructions are for the removal and replacement 
of the pump check valves for the ACCQPrep HP150 system.

1. Turn the power OFF. 
2. Access the pump compartment by grabbing the edges of 

front panel and pulling forward on both sides 
(Figure 5-18).

Figure 5-18Front panel of the ACCQPrep
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3. The solvent supply lines to the pumps have fluid in them 
that are drained during this procedure. If draining this 
fluid back into the supply bottles is acceptable, follow step 
3a below; if not, go to step 3b.
a.  Place the solvent supply bottles below the instrument. 

Next, loosen the solvent supply fitting that enters the 
‘Y’ fitting below each pair of pump heads. This allows 
the fluid to drain back into the supply vessel.

b. Remove the solvent supply lines from the solvent bot-
tles. Place a tray or absorbent pad beneath the ‘Y’ fit-
ting below each pair of pump heads. Loosen the fitting 
entering the ‘Y’ fitting to allow the solvent to drain 
from the supply lines.

4. Remove the two screws securing the pump assembly in 
place shown in Figure 5-19 using the included 3/16" hex 
key.

Figure 5-19Location of the pump assembly  
mounting screws

5. Remove the two stainless steel outlet lines connected to 
the bulkhead fittings using a 1/4" wrench. Remove the two 
bottom inlet lines going to the bottom ‘Y’ fittings and dis-
connect the pump drive connector (Figure 5-20).

6. Remove the Pump Communication Connection located 
behind the right side arrow pointing to the outlet lines 
(Figure 5-20).

Pump assembly mounting screws
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Figure 5-20Pump assembly

7. Pull the pump assembly forward to the position shown in 
Figure 5-21. 

Figure 5-21Pump assembly 

8. With the pump assembly pulled out, remove the inlet fit-
tings connected to the bottom of the pump head. Using a 
1/4" wrench, remove the stainless steel outlet lines on the 
top of the pump head (Figure 5-22). 

Figure 5-22Location of fittings

 Outlet lines Inlet lines Pump drive
connector

Outlet lines removed Inlet lines removed 
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9. Using a Phillips screwdriver, remove the ‘Y’ fitting located 
above pump heads (Figure 5-23).

Figure 5-23Location of tee mounting screws 

10.Using a 1/2" wrench, remove the check valve housings 
from the top and bottom of the pump heads (Figure 5-24). 
With the check valve housings removed, remove the exist-
ing check valve cartridge and install the new check valve 
cartridge into the housing. Make sure the arrow on the 
body of the check valve cartridge is pointing upwards in 
the direction of the flow (Figure 5-24).

Figure 5-24Check valve housings (top) and inlet check 
valve and housing (bottom) 

Note
On an outlet check valve, the arrow is reversed. 

11.Reinstall the check valve housings into the pump heads 
and tighten. Reconnect the ‘Y’ fittings removed in step 5 
and reconnect the inlet and outlet lines. Reassemble the 
instrument in the reverse order of disassembly. 

12.Place the solvent supply lines into the proper connectors 
and reprime the system.
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5.6 AutoSampler 
Maintenance

The Peristaltic pump on the back of the AutoSampler may need 
replacement.

Peristaltic Tubing 
Replacement

Peristaltic tubing part number: SP7477.

Figure 5-25Back of the AutoSampler 

1. Remove the outer band of the peristaltic pump 
(Figure 5-26).

Figure 5-26Removing the outer band 

2. Lift up to remove the peristaltic tubing from the pump, 
repeat on the bottom (Figure 5-27).



ACCQPrep HP150 
Section 5   Maintenance

5-19EAR99 Technology Subject to Restrictions Contained on the Cover Page

Figure 5-27Removing the tubing 

3. Slide the new peristaltic tubing with the thicker tubing 
towards the AutoSampler (Figure 5-28).

Figure 5-28Attaching the new tubing 

4. Replace the outer band of the peristaltic pump (Figure 
5-29).
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Figure 5-29Replace the outer band 

5.7 ELSD Maintenance Periodic cleaning of the spray chamber will keep the ACCQPrep 
operating at maximum performance. Follow the steps below if 
spray chamber cleaning is recommended:

5.7.1 Cleaning the ELSD 
Detector

1. From the RUN SCREEN, open the METHOD EDITOR.

2. At the Peak Detection section, select ELS DETECTOR, then 
select DETAILS. The DETECTION OPTIONS window opens.

3. Set the spray chamber temperature to 40 °C.

4. Exit the METHOD EDITOR and accept the changes. Allow 
approximately 5 minutes for the chamber to reach the set 
temperature.

Figure 5-30ELSD Detection Options window

5. Lift the P-trap drain tubing up to approximately case top 
level. Using a wash bottle, syringe, or suitable measuring 
device, slowly fill the drain line with up to 40 mL of ace-
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tone. Lift the end of the tubing as needed to transfer most 
of the liquid into the spray chamber. Make sure the fluid 
level in the tubing doesn’t exceed the level of the instru-
ment case top. If the tubing is raised too fast, fluid may 
flow out the top of the vent tube causing a spill. Hold the 
tubing up for at least 1 minute after the fluid has been 
transferred to the spray chamber.

Figure 5-31Line filled with 40 mL of acetone

6. Place the open end of the P-trap drain line in a 100 mL (or 
greater) beaker.

Figure 5-32Draining the acetone into a 100 mL  
beaker

7. Allow the acetone to drain out of the unit by dropping the 
end of the P-trap drain line, while it is in the 100 mL bea-
ker, below the P-trap drain line level.

8. Fill the P-trap pump drain line with up to 40 mL of isopro-
pyl alcohol using the same procedure as step 5.

9. Place the open end of the P-trap drain line in a 100 mL (or 
greater) beaker.
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10. Allow the isopropyl alcohol to drain out of the unit by drop-
ping the end of the P-trap drain line, while it is in the  
100 mL beaker, below the P-trap drain line level.  

11. From METHOD EDITOR > ELSD DETECTOR DETAILS > 
DETECTOR OPTIONS, set the spray chamber to 60 °C.

12. Fill the P-trap with up to 40 mL of isopropyl alcohol as 
before and drape the P-trap drain line of the top of the unit 
and let it set for at least 20 minutes.

13. Allow the isopropyl alcohol to drain out of the unit by drop-
ping the end of the P-trap drain line, while it is in the  
100 mL beaker, below the P-trap drain line level.  

14. To ensure that there is no fluid remaining in the drift tube, 
set the drift tube to 90 °C. Open MANUAL CONTROL to turn 
the gas on and let run 10 minutes. Turn off the gas.

15. Select FILE and then NEW to reset the method tempera-
tures. Use the instrument normally.

Note
During the rinse steps, it is normal to have flakes or particles in 
the wash liquid.
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5.8 PurIon Maintenance

5.8.1 ESI and APCI Removal 
from PurIon S and 
PurIon L

Refer to Figure 5-33.

1. Place the mass spectrometer in STANDBY mode.

2. Unscrew the ¼-28 PEEK fitting at the top of the ion source 
housing.

3. Loosen the two clamps at both sides.

4. Gently lift and pull out the source housing.

Figure 5-33  ESI and APCI removal from PurIon S and PurIon L

5.8.2 ESI and APCI 
Replacement PurIon S 
and PurIon L

1. Carefully place the ion source housing on top of the base 
plate and line up with the rear electrical connection. Push 
down until source chamber is seated evenly across the base 
plate.

2. Lock down two housing clamps at both sides.

3. Finger-tighten the ¼-28 PEEK fitting at the top of the 
source housing.

5.8.3 Cleaning the 
Ionization Source 
Capillary

Plugging of the capillary (either in the ESI or APCI probe) causes 
the pressure of the carrier fluid from the fluid interface to exceed 
the maximum operating pressure indicated by Error 310 or Error 
316. This error can be avoided by filtering directly injected 
samples through a 0.45 µ syringe filter. To unplug the capillary, 
complete the following:

1. Using adapters as needed, connect a 1 mL syringe to the 
ESI or APCI capillary, then push fluid through to remove 
plug. If this procedure does not resolve the issue, an HPLC 
pump can be connected to the inlet fitting.

2. If this procedure fails to unplug the capillary, refer the 
instructions for the rebuild kit provided with your PurIon 
system.

3. Reinstall the probe following the appropriate procedures 
for your system.
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5.8.4 Replacement of Ion 
Source Housing

1. Place the ion source housing on top of the base plate and 
line up with the rear electrical connection. Push down until 
source chamber is seated evenly across the base plate.

2. Finger tighten the two thumb screws and finger tighten 
the ¼-28 PTFE tube fitting labeled as 'heated desolvation' 
on the side of the housing. 

5.8.5 Overpressure Error The fluid interface has a pressure transducer to monitor 
pressure of the carrier fluid. Since the sample is introduced at 
the splitter valve, plugs usually occur between the valve and the 
PurIon source sprayer. The most common location for a plug is 
within the probe capillary. The occurrence of plugs can be 
reduced by using a 0.45 µ syringe filter when injecting samples 
for Method Development and Ionization Settings. To trouble-
shoot an overpressure error, complete the following:

• If the error occurs during a run, select CONTINUE 
WITHOUT PURION, The purification can continue 
without the PurIon signal or peak detection, but it will 
rely on any other detector selected such as UV or ELSD. 
This allows the run to be completed before trouble-
shooting the plug.

• Select MS > MANUAL CONTROL.

• Select START CARRIER PUMP.

• Watch the pressure on the ribbon gauge.

• Loosen the fitting at the source inlet. If the pressure 
drops, then the source capillary is plugged.

• If there is still an error or the pressure remains high, 
then the plug is between that point and the splitter 
valve (or the valve itself). Continue to loosen fittings 
going back the to the splitter valve until the error is 
corrected.

5.8.6 Check Valve Cleaning If the check valves are allowed to dry out after using volatile 
salts (e.g., ammonium acetate or ammonium formate), they may 
stick and fail to function. Complete the following to clean the 
check valves:

1. Remove the inlet and outlet lines from the check valve 
holders (Figure 5-34), then remove the check valve holders. 
Pliers may be needed to remove the holders.
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Figure 5-34  Check valve holder

2. Remove check valves from pump head and place in a bea-
ker of methanol. Sonicate check valves for 15 to 20 min-
utes.

3. Reinstall check valves into the pump head, making sure 
that the ends of the check valves (with multiple holes) are 
facing up towards the outlet of the pump.

4. Reinstall check valve holders and tighten finger tight. 
Then using pliers tighten an additional ¼ turn.

5. Check the flow rate delivery. If the flow rate delivery is still 
incorrect, replace the check valves. The correct flow rate 
depends on the back pressure of the carrier solvent. The 
flow will be 0.5 mL/minute until the fluid interface reaches 
operating pressure, then it reduces the flow rate to 
0.2 mL/minute under typical operating conditions for the 
fluid interface. The operating mode can be determined by 
listening to the pump operate. While running at 
50 mL/min, the pump motor speed is continuous. After 
operating pressure is reached, the pump performs a rapid 
refill stroke approximately every 8 seconds.

5.8.7 Replacing Check Valves 1. Install new check valve cartridges (PN 250-0001-17) into 
pump head housing making sure the ends of the cartridges, 
with three small holes, are facing upwards towards the 
outlet (Figure 5-35). 

Figure 5-35  Correct orientation of cartridge 

2. Tighten check valve holders finger tight, then with pliers 
tighten an additional ¼ turn.

5.8.8 PurIon Cone Cleaning This error occurs if the capillary inlet to the PurIon vacuum 
region is restricted causing a higher vacuum reading than 
normal. PurIon S & L models compatible with the NextGen 
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systems have an internal valve that allows removal of the cap-
illary inlet without venting the vacuum system to allow easy 
cleaning. Even with the easy cleaning capability, Teledyne LABS 
recommends keeping a spare capillary inlet cone assembly (PN 
25-0000-085) to allow rapid replacement to minimize downtime 
while cleaning the plugged capillary.

5.8.9 Capillary Inlet Cone 
Removal

1. Set the PurIon to standby. 

2. Wait ~15 minutes for the cone to cool.

3. Remove the ion source assembly. See section 5.8.3.

4. Wearing gloves (typical lab gloves are usually sufficient), 
place your fingers on the top surface of the cone and turn 
counterclockwise to unscrew the capillary inlet cone. Often 
this is sufficient to remove the capillary. If you are unable 
to unscrew the part manually, use an adjustable wrench on 
the flats of the cone to unscrew them. The flats are not 
large, and they may be difficult to see while a wrench is 
seated on them. 

5. Remove the O-rings from the capillary inlet cone. 

5.8.10 Capillary Inlet Cone 
Cleaning

1. Remove the O-ring under the capillary base, then sonicate 
the capillary in a methonal:water (50:50) mixture for 
30minutes (Figure 5-26).

Figure 5-36Location of O-Ring

2. If heavily contaminated, sonicate in methanol:water + 1% 
formic acid (50:50) mixture for an hour.

3. Rinse the capillary thoroughly with acetone, isopropanol, 
methanol then dry the capillary using nitrogen air.

5.8.11 Capillary Inlet Cone 
Installation

1. Ensure that the O-ring seals are in position. 

2. Place the capillary inlet cone into the opening and press 
down until the threads are able to engage. There may be 
slight restriction in a downward motion as the part is 
almost completely inserted. This is the capillary opening 
the valve to the vacuum region.

3. Screw the capillary inlet cone into the inlet. Finger tight is 
sufficient as long as the part is fully seated.

4. Replace the ion source. 

5. Place the PurIon in the operate mode.

5.8.12 PurIon 
Troubleshooting

If your instrument stops working and the touch panel display is 
off, check the line cord connection.
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If the line cord is connected properly, check circuit breaker on the 
system’s rear panel to ensure it is switched to the ON position.

Table 5-1  Common PurIon 
Error Codes and Resolutions 

PurIon temperatures are stabilizing.

[r] seconds remain. (where [r] is a number)

The PurIon has several areas with heaters. The software 
has a set timer to allow temperatures to come up to oper-
ating conditions. After that time, a separate error is thrown 
if the heaters are not within an acceptable band. The 
default time is 300 seconds after entering the operate 
condition.

During the standby condition most heaters are set to OFF 
except the inlet capillary with is set to 50 °C during 
standby.

The PurIon vacuum level is too low to operate. Verify that 
the roughing pump is on and operating correctly.

Pirani Pressure: [s1] mbar. (where s1 is the vacuum read-
ing).

The Pirani pressure must be below 5.5E-3 mbar before 
the PurIon turbo pump will operate. If trying to place the 
PurIon in operate without turning on the roughing pump, 
this message will appear.

This error generally occurs if turning on the roughing 
pump back is forgotten after cleaning the capillary or 
changing the pump oil.

The PurIon has been shut down. It will be unavailable for 
use until the NextGen has been rebooted. Ensure the 
PurIon and fluid interface are both turned on before 
rebooting the NextGen. 

This message is displayed after the PurIon has been suc-
cessfully shut down through the SHUTDOWN command. It 
serves as a reminder that an NextGen reboot will be nec-
essary for the PurIon to be enabled again by the Next-
Gen.

The splitter valve seals have exceeded their recom-
mended life. The PurIon will continue to operate, but 
there is an increased possibility of leakage at the splitter 
valve and loss of PurIon detection during a separation.

The splitter valve supplier has stated that typical valve life 
exceeds 1,000,000 actuations. After that time, there is no 
method of determining when it will leak. The valve can be 
rebuilt using the valve rebuild kit (PN 60-5234-629) or 
continue to use and monitor for leakage. Leakage should 
not drip out the bottom of the fluid interface front cover.

No ion source is detected on the PurIon. Verify that the 
ion source is properly installed and connected. If the 
source is still not detected, contact a qualified service 
technician. Error 309

The PurIon has reported that the ion source high voltage 
cable is not properly plugged into its socket. This is the 
cable with the round connector and is to the right and 
behind the ion source.

This generally occurs upon changing or cleaning probes.

A plug has occurred in the PurIon fluid lines. The separa-
tion can be continued without PurIon detection or contin-
ued if the plug is corrected. Error 310

This error message is displayed if a plug is detected 
during a separation.

The PurIon inlet cone may be plugged, which could pre-
vent detection. Continued operation will not cause dam-
age. Contact a qualified service technician to clean the 
cone; Pirani Pressure: [s1] mbar. Error 315

During normal operation, the Pirani pressure should be 
>1.5E-3 mbar. Anything less is an indication of either par-
tial or complete plugging of the capillary cone entrance to 
the vacuum area. See cleaning the cone capillary (5.8.3).

A plug has occurred in the PurIon fluid lines. The plug 
must be corrected to allow continued operation. Error 
316.

This error occurs if the tubing is plugged while the 
method development screen is in use. See cleaning the 
probe capillary (5.8.3).

The ionization probe (ESI or APCI) isn’t fully seated into 
the ion source housing. Verify that the probe is fully 
seated, then select OK to continue. Error 317.

On PurIon systems (not PurIon S or PurIon L), the probe 
isn’t seated properly. Loosen the thumbscrew on the front 
of the ion source housing, push down on the probe, then 
tighten the thumbscrew.

The fluid interface pressure is too low. Error 325 This could be due to lack of carrier fluid, loss of pump 
prime, or leakage.



ACCQPrep HP150 
Section 5   Maintenance

5-28 EAR99 Technology Subject to Restrictions Contained on the Cover Page



A-1EAR99 Technology Subject to Restrictions Contained on the Cover Page

 
ACCQPrep HP150

Appendix A  

A.1 Diagrams for the 
AutoSampler and 
ACCQPrep

The following diagrams are for connecting the AutoSampler to 
the ACCQPrep system. These diagrams include:

• A tubing diagram of the connections from the 
AutoSampler to the ACCQPrep (Figure A-1)

• A wiring diagram of the USB connections from the 
AutoSampler to the ACCQPrep (Figure A-2)
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Figure A-1 Tubing diagram 
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Figure A-2 Wiring diagram 
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